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Preface 0
e 

 and 

ogin.
About This Manual

This ezCallerID System Administration Manual provides all the information the system 
administrator needs to install, maintain, and troubleshoot the ezCallerID software. Additional 
procedures cover some of the initial steps the ezCallerID System Administrator must 
perform—add service centers, add privilege levels, and add user IDs.

Audience

The ezCallerID System Administration Manual is for installing the software, monitoring th
software processes, and maintaining the system.

Where to Find Information in the Manual

Use this guide to start installing the ezCallerID system or as a reference to sections:

• Chapter 1 is an introduction to the ezCallerID.

• Chapter 2 provides step-by-step instructions for configuring the third-party databases
installing the ezCallerID application.

• Chapter 3 describes how to set up the gateway so the Service Representatives can l

• Chapter 4 contains instructions for configuring the communication link for Service 
Centers.

• Chapter 5 provides maintenance information.

• Appendix A contains a glossary of abbreviations, acronyms, and definitions.

• Appendix B is your technical reference section.

• Appendix C is a catalog of application windows and field definitions.
November 15, 1999 1091-B DRAFT xvii



Preface ezCallerID System Administration Manual

r.

e.
Viewing the Manual in Online Format

To effectively adjust the page layout to view this user’s guide online:

1. Double-click the PDF file of this guide using the Microsoft® Windows Explorer®.

The ezCallerID System Administration Manual displays using the Acrobat™ Reade

2. Click the magnifying glass icon at the bottom of the window.

The Zoom To window displays to let you choose the display magnification.

3. Type 150% for the Magnification and click OK.

Conventions

This manual uses specific conventions to help you recognize what to do with the softwar

Example Convention Description

a xxx yyy Courier bold Indicates commands you need to enter

Press Return
Press Tab

Arial bold Indicates keys you press on the keyboard

<Control+O>

Dual angle brackets (< >)
Dual angle brackets and plus sign 
(+)

For key commands, the plus sign indicates to hold 
down the first key and press the second key.

Click OK Arial bold Indicates buttons in a GUI interface requiring 
input or activation; clicking a button, or choosing 
an item from a drop-down selection list.

File pull-down menu
File > New
Insert > Picture >File

Arial bold plus one (or more) 
brackets (>)

Describes selecting a command from a pull-down 
menu or a sequence of cascading menus.

File > New 
Then next,  Type 

new name in window

Action Then next,  Action 
Then next,  Action 
Then next,  Action

Provide actions so a user can reach a specific 
user-interface window.
xviii 1091-B DRAFT November 15, 1999
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What’s New in this Release

The most significant changes in software Version 2.0 are:

• The OSS server is now compatible with MetaSolv’s Telecom Business Solutions (TBS
layer using a Common Object Request Broker Architecture (CORBA) interface. This 
enables existing and multiple system configurations to communicate with the ezCalle

• The ezCallerID documents are only stored in an Oracle persistent database.

Manual Sections That Changed

• This document now conforms to the DSET Carrier Solutions Technical Communications 
Standards and Style Guide.

• There are two possible installation configurations for the ezCallerID application:
- Standalone GUI - Use a persistent Oracle database to store large numbers of 

ezCallerID customer orders with a standalone Java-based GUI software.
- Inegrated - Use an OSS interface to permit a large number of service representati

create customer orders and store them in an Oracle database.

• Revised index to identify more system administrator tasks.

• Insert section to show Oracle DBA the key steps necessary to setup the Oracle datab
required for the DSET ezCallerID application.
November 15, 1999 1091-B DRAFT xix
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Getting Technical Support

Contacting Customer Service

Online Help

Many fields in ezCallerID windows have short, context-sensitive descriptions that display in 
the Status bar located along the bottom of each window. Place your cursor in a window field to 
display its corresponding description.

Table Preface-1: Contacting DSET’s Customer Service

Contact Method Address or Number

Internet TBD

Website http://www.dset.com/tech/
techsupport1.html

Telephone
   Technical Support
    Customer Service

877-ASK-DSET
972-312-1800

FAX: 972-312-9060

Mail: DSET Corporation
2201 West Plano Parkway
Plano, TX 75075
USA
xx 1091-B DRAFT November 15, 1999
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Understanding the ezCallerID
When a customer wants a new telephone service provider, they contact a Competitive Local 
Exchange Carrier (CLEC). The CLEC must communicate with the customer’s current se
provider, the Incumbent Local Exchange Carrier (ILEC), to change the service.

There are many pieces of information that are part of telephone service, one of these pie
the Line Information Database (LIDB) information. It contains information relating to the 
customer’s name, calling card, security code, and third party billing.

Background Information

A telephony service provider uses a Line Information Database (LIDB) to store subscriber
for a set of telephony services. 

Line Information Database services can include:

• Alternative Billing Services (ABS)

– Calling Card Service

– 3rd Party Billing Service

– Collect Billing Service

• Calling Name (CNAM)

• IntraLATA Presubscribed Carrier (ILP) - local long distance carrier information

• Originating Line Number Screening (OLNS) - defines calling restrictions on an origina
line

• Specific Call Number Blocking (SCNB) - defines blocking calls for numbers or sets of
numbers.
November 15, 1999 1091-B DRAFT 1-1
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• GetData - defines custom services and data set up

In addition to being a repository for subscriber data, LIDBs are revenue-generating entitie
the their owners.  For example, a customer subscribes to calling name presentation.  Wh
subscriber originates a call, the called party's CNAM data must be retrieved from a LIDB
There is a fee charged for accessing this information.  The database accesses are frequ
referred to as dips.  Each dip into a LIDB results in revenue for the LIDB owner.

CLECs have several options available for building and maintenance of LIDBs:

• Share LIDBs with the ILECs (thus sharing revenue from dips)

• Contract the LIDB out to 3rd party companies

• Build and maintain the LIDBs in-house.

Regardless of how the CLECs maintain their LIDBs, updates to the LIDBs are required 
whenever customer is added, modified, or deleteed from their network. Using a software
interface, with data-entry validation (instead of a manual, error-prone, and time consumi
procedure), and an electronic data transfer gateway results in faster Line Database upda
generates CLEC revenue faster. The time spent filling-out paper forms, faxing or mailing
forms to the LIDB entity, and making corrections is eliminated; reducing staff expenses fo
CLEC.

The Market

The Telecom Act of 1996 opened up the local telephone market to competition.  Present
there are 250-300 facilities-based Competitive Local Exchange Carriers (CLECs).  Unlik
Local Number Portability (LNP) and E911 federal mandates, LIDBs are an optional servi
However, since they are revenue-generating entities, CLECs are likely to deploy LIDBs (
some form) as soon as possible.  

Based on features offered by the ILECs:

• CNAM and ABS are a high priority LIDB data for residential subscribers.

• OLNS and SCNB are more important LIDB data to maintain for business subscribers
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DSET’s Current LIDB Service Gateways

DSET currently offers two LIDB gateway products, ezCallingCard and ezCallerID.  These 
gateways are designed to bridge the gap between a CLEC’s OSS and Illuminet.  Illuminent is a 
company with a Signaling System 7 (SS7) network and access or access agreements to the 
LIDBs for each of the ILECs. Illuminet provides a standard interface and protocol for all 
CLECs and hides the details necessary to access the individual Line Information Databases. 
Illuminet provides CLECs the ability to update LIDBs with CNAM, ABS, and OLNS feature 
information.

Version 1.0 of the ezCallerID supports a browser-based graphical user-interface (GUI) for 
ezCallerID customer order data entry and viewing. It collects the orders, stores them locally, 
creates data transfer files, and sends the files to Illuminet.  The ezCallingCard gateway 
supports features similar to the ezCallerID. There is no gateway at this time for changing 
OLNS data.

Illuminet does not presently support the file transfer protocol (FTP) for sending the Customer 
orders are saved in ASCII format on diskettes and sent to Illuminet.

Overview

An ezCallerID transaction works like this:

1. Customer wants to add, change, or delete calling name information.

2. The request is entered either directly in the ezCallerID, or through an existing system 
which communicates with the Operating Support System (OSS) server.

3. The request is stored in two formats, one for ezCallerID and the other for the UNIX File 
System (UFS).

'LVFXVV�YDULDWLRQ�ZLWK�ZLWK�WKH�GLIIHUHQW�FRQILJXUDWLRQV�XVLQJ�266�YV��7%6�
DQG�WKH�81,;�)LOH�6\VWHP�YV��2UDFOH�SHUVLVWHQW�GDWDEDVH�

4. Next, the request is sent to the Service Center according to the data transfer schedule 
defined by your system administrator. The Service Center is a pick-up stop for the ILEC.
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5. The ILEC picks-up the request and verifies the data against their information. A 
notification message is returned to the Service Center indicating the condition of the 
request.

6. The UFS retrieves the message from the Service Center and it displays for the Service 
Representative to read.

7. The notification message can dictate two outcomes:

a. If accepted, the transfer is complete and the customer is ‘provisioned’. The CLEC
the ezCallerID information so they can provide complete service for that custom

b. If not accepted (due to errors), the errors are corrected using the ezCallerID and
request is once more sent.

Order Status

Every Caller ID customer order has a status definition. The status definition describes th
current state of the order from its initial creation to the point of order completion.

Table 1-1: Order Status States (1 of 2)

Status Description

Completed Order item is successfully provisioned.

Create/Edit
The customer order is currently being modified in the 
ezCallerID GUI.

Canceled The order was canceled before it was finished.

Released Order is ready to be provisioned.

System Processing
The order was sent to the supplier via the ezCallerID and 
interface and is “in progress”.

Manual Processing
The order is on a user’s work list and is awaiting an update to 
complete the provisioning.

Supplier Processing Complete
Supplier processing on the order is complete. This typically 
happens when a supplier sends a provisioning complete 
response via an automed interface.
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Due Dates

In the ezCallerID customer order, there are two time intervals defined that influence its actions 
with respect to the Due Date. The Due Date is the target date which the CLEC has set for 
making the service avaliable to the customer.

• Provisioning Interval—the time between the initial order is made and the Due Date; ti
the CLEC believes it will take to make ezCallerID service available to the customer.

• Jeopardy Interval—a shorter time interval, in the time period prior to the due date. If a
order item is not completed or canceled before the jeopardy interval, the probability o
missing the Due Date increases.

At any intsant an ezCallerID customer order ccan be in one of six states.

Manual Processing Complete
Typically occurs when a user finishes working on an order 
and the business process begins system processing.

Error During provision this order an error happened.

Hold
The order requires further editing before it can be released 
for provisioning.

Post Complete Follow-up
A manual follow-up must be done (that is, call customer and 
confirm the Caller ID service is working) before the order is 
considered complete.

Post Complete Follow-up Done
Any post completion follow-up activity is done and nothing 
else is required to track the order.

Table 1-2: Due Date States (1 of 2)

State Description

Finished Order is completed or canceled.

On Time
The order items associated Due Date will not be 
missed.

Jeopardy The order is within the Jeapordy Interval

Table 1-1: Order Status States (2 of 2)

Status Description
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Late
The Due Date has passed and the order is not 
completed or canceled.

Negotiate
A request to the customer was sent to chnage the 
Due Date for an order in progress.

Escalate
Priority of the work necessary to complete the 
ezCallerID order is increased.

Table 1-2: Due Date States (2 of 2)

State Description
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The ezCallerID Components

• The GUI windows and OSS—for manipulating an Line Information DataBase (LIDB) 
customer record

• The Interconnectivity Gateway Platform (IGP), Security Agent, Oracle database, and
activity logs—for processing the order requests 

• The DownStream Interface (DSI)—for collecting and translating the data into recogni
formats

• The Telecommunications Business Solutions (TBS) interface or the Operational Supp
System (OSS).

• The Service Center—for sending and receiving data from the ILEC

Generating a Request

Requests for transferring Caller ID information enter the ezCallerID two ways.

The Operations Support System (OSS) Server

The Operations Support System (OSS) uses the industry standard CORBA language. T
ezCallerID software release (2.0) features Metasolv’s Telecom Business Solutions (TBS
is compatible with the OSS. This allows many existing ezCallerID data-entry systems to 
continue operating with the new technology. 

The ezCallerID CORBA Gateway:

• Receives Caller ID requests in the CORBA Interface Definition Language (IDL) forma
from the CLEC’s OSS

• Converts CORBA Caller ID requests into an internal format (ASN.1) for processing wi
the LSR Gateway and sends them to ILEC Service Centers

• Receives notification messages from the ezCallerID IGP

• Converts messages back to the CORBA IDL format

• Sends CORBA messages to the CLEC
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The ezCallerID GUI

Processing a Request

ezCallerID Interconnectivity Gateway Platform (IGP)

The ezCallerID IGP is the nucleus of the ezCallerID. It does the actual processing of the tasks 
the users perform. The ezCallerID IGP:

• Creates, modifies, and displays ezCallerID documents.

• Displays Notification and Error messages.

• Creates, modifies, and displays DownStream Interface (DSI) and Service Center 
information.

• Displays Log files .
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Figure 1-1: ezCallerID Interconnectivity Gateway Platform

Security Agent

When a user enters the ezCallerID, login information is validated by the Security Agent. The 
Security Agent accesses a database (sec_db) and validates the user ID and password.

If the user ID is valid, the Security Agent sends a message to the ezCallerID Gateway 
confirming the ID. Otherwise, the Agent sends back an invalid user message and login is 
denied. It also insures users are not able to perform functions outside of their authority.

Figure 1-2 illustrates the user ID validation process by the Security Agent.
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Figure 1-2: The Security Agent Process Flow

The validation occurs during initialization and lasts for the duration of the ezCallerID session.

Oracle Database

Logs

Converting to A Common Format

Before requests can be sent to the ILEC, it must be converted to a format that the ILEC can 
read. This is done in the DownStream Interface (DSI).

DownStream Interface (DSI)

When data is transmitted through the DownStream Interface (DSI), it flows through two 
components:

• Collector

• Translator
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It receives, translates, and forwards ezCallerID requests, Notification messages and Error 
messages between the ezCallerID system and the UNIX file system. The DSI also holds 
scheduling information to trigger the collector/translator and send/receive documents to/from 
the UNIX file system.

Collector

The Collector component of the DSI periodically checks the ezCallerID IGP for documents in 
Pending status. Pending indicates the document is ready to be sent. It also receives Notification 
messages and Error messages arriving from the Service Center.

The Collector time interval is configurable from the ezCallerID interface. When the Collector 
receives the ezCallerID request, it invokes the Translator component of the DSI.

Translator

The Translator converts the ezCallerID request in the Collector from ezCallerID format to 
ASCII format for the UFS. The Translator also reads the Notification and Error messages 
arriving in the opposite direction from the Service Center. These are converted from ASCII 
format back to the ezCallerID format.

Information Types

There are two types of information transmitted between the Service Center and the ezCallerID. 
Each type of information glows in a specific direction:

• ezCallerID Request information - ezCallerID request flows are called Downloads; the 
information in the ezCallerID request travels from the ezCallerID down to the Service
Center.

• Notification Message information - Notification messages flow are called Uploads; the
message travels from the Service Center up to the ezCallerID.
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The ezCallerID Requests - Download

This illustrates the ezCallerID request download process.

Figure 1-3: Download Process of ezCallerID requests
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The Service Center

The Service Center is similar to an electronic mail drop. ILECs deposit Caller ID document 
requests, and CLECs deposit Notification Messages. Both the ILEC and the CLEC pick up 
(exchange) the data at scheduled time intervals.

Service Centers are usually configured for each major ILEC. For example:

A Service Center would be established for Bell Atlantic. It would service all customers in 
New Jersey, Delaware, Pennsylvania, West Virginia Washington D.C., and Michigan.

A second Service Center would exist for Bell South customers in Kentucky, Tennessee, 
North Carolina, etc.
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Installing ezCallerID 2
Overview

This chapter describes how to install and configure the ezCallerID application. You can think 
of this software installation as divided into six major sections:

1. Pre-installation Tasks .......................................................................................  on page 2-2

2. Install Third-party Software ............................................................................  on page 2-4

3. Create Oracle Databases ..................................................................................  on page 2-7

4. Prepare the Basic DSET Product Environment .............................................  on page 2-22

5. Install the DSET ezCallerID application .......................................................  on page 2-32

6. Post-installation Tasks ...................................................................................  on page 2-46
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Pre-Installation Tasks

Complete the ezCallerID Pre-Installation Checklist before you create Oracle databases, 
prepare the Basic DSET environment, install the ezCallerID application, and perform post-
installation operations.

Table 2-1: ezCallerID Pre-Installation Checklist 

Check here... if you have this Installation Requirement

❏ Server - Sun™ SPARC® 20 Central Processing Unit (CPU) or better

❏ Minimum of 128 Mb of RAM

❏ Minimum of 150 Mb hard disk space for ezCallerID software

❏ Minimum of 230 Mb hard disk space for optional Orbix, TBS, and Oracle software

❏ SUN Solaris® 2.5.1 or later with all year 2000 patches installed

❏ UNIX® Korn Shell (ksh) Industry Standard

❏ An Internet browser that supports Java applets (Java Developers Kit 1.1.5 or later) 
DSET recommends Netscape® Communicator (version 4.06 or later) or Internet 
Explorer (version 4.15 or later).

❏ The DSET ezCallerID installation tape (4mm or 8mm) or CD-ROM containing the 
ezCallerID 2.0 software.

❏ [CORBA/OSS only] If you intend to use the MetaSolv Telecom Business Soluion™ 
(TBS) application, you must have TBS v4.0.1 software.

❏ [CORBA/OSS only] If you have chosen to create an integrated solution, you need to 
have the UNIX Orbix™ v2.3.c  software from IONA Technologies PLC.

❏ [CORBA/OSS only ] Home directory pathname for the Orbix v2.3.c software.

❏ Determine the Installation directory where to install the ezCallerID. The UNIX 
file directory should be empty. See "DSET Application File Directories" on page 2-24 
for a better understanding the file directory structure.

❏ Oracle server  version v8.0.5.

❏ Download the latest Oracle software patches for v8.0.5.

❏ Oracle name for CNAM Document Database instance.

❏ Oracle name for Security Agent Database instance.
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References

These books provide more information about the ezCallerID installation. The System 
Administrator should have a copy of each.

• Solaris Operating System 2.5.1 Administration Guide, Volume 1

• SunLink 8.1 Communication Platform Administrator’s Guide

• Orbix Administrator’s Guide — Orbix 2 (v2.3)

• Oracle 8 Release 8.0.5 for SUN SPARC Solaris 2.x Administrator’s Reference

• Oracle DBA Handbook 8.0 Edition

• ezCallerID User’s Manual
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Install Third-party Software

Creating the basic DSET environment for all Gateway applications requires the ezCallerID 
System Administrator to make several key decisions:

• Determine if your company wants to use MetaSolv’s Telecom Business Solutions soft
for an Integrated solution or use a simple stand-alone GUI. You must install IONA 
Technologies Orbix software if you want to use MetaSolv’s TBS product.

• Determine if you want to install a remote CORBA server as the gateway.

The previous two decisions determine which installation configuration your company will
with the DSET ezCallerID product. 

Oracle Software Requirements

To use Oracle with DSET products, you must use:

• Enterprise Server 8.0.5 with Oracle 8 Objects Option enabled.

• The latest v8.0.5 software maintenance patches.

• Must have the version SQL*NET V2 set-up for distributed databases.

• The two ezCallerID Oracle databases must be created with the options:

– Character set used is WE8ISO8859P9 (ISO-8859-1 West European standard).

– Name of the Oracle tablespace used is “DATA”. All the database tables and indices ar
stored in this tablespace. 
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Oracle Server Software

To use Oracle to store the CNAM orders (documents) and implement security for User IDs and 
passwords:

1. Have your company’s Database Administrator install Oracle server version v8.0.5.0 on 
the UNIX machine you will use with the ezCallerID application.

2. Install the latest Oracle 8.0.5 software maintenance patch to address recent Oracle
software problems.

3. Download the most recent Oracle software patch files:

(a) Go to the ftp site with the TCP/IP addresss of 209.246.5.40 .

(b) If a User ID is requested, use an Anonymous FTP login with the values:
User ID - anonymous
Password - <Insert your email address>

(c) Change to this directory to locate the latest 8.0.5 software patch files
/server/patchsets/unix/SUN_SOLARIS2/80patchsets/

(d) Change to the latest subdirectory. The patch files (at the date of this manual’
publication) are found in subdirectory /80521 .

Note: The files in the Patch sets are cumulative.  For example, 8.0.5.3 includes all the fixes in 8
and 8.0.5.2 as well as new fixes for 8.0.5.3.  This means that unless the patch set 
documentation indicates otherwise, the patch set can be applied to any earlier 8.0.5 vers
There is no requirement to install all intermediate patch sets.

4. View the patch_note.html document using a web browser to understand:
> System requirements for installing the patch
> Instructions for installing the patch
> List of bugs fixed with this and previous patches
> De-installing patch procedures.
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5. Follow the instructions to install the Oracle 8.0.5 software patch found in:

solaris_8052patchset.z (18.1 Mb - 9/27/99)

6. Since the bug patch bug991197 is applied to Precompiler 8.0.5.2.1 on a Sun Sparc 
Solaris, follow the instructions and apply this patch also. the instructions are found in the 
file.:

/bug991197/README.991197

7. Be sure to use the WE8ISO8859P9 character set option when creating both the CNAM 
document and the CNSECDB Security Agent databases. (See "Create Oracle Databases" 
on page 2-7.)

8. Ensure that the Oracle 8 Objects Option and Network Option are set (enabled).

CORBA Software

• Install Orbix v2.3.c if you want to use the MetaSolv Telecom Business Solutions (TBS
software as an Operational Support System (OSS), according to documentation prov
by IONA Technologies PLC.

Integrated OSS Configuration

• Install TBS v4.0.1 according to documentation provided by MetaSolv Software.

CAUTION

De-Installing a Patch Set: There is no mechanism provided for de-installing patch sets. If 
are concerned about being able to de-install a patch set, Oracle Corporation recommen
you back up your software installation, before applying the patch set..
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Create Oracle Databases

The ezCallerID default installation requires an Oracle database to store orders and perform 
system security administration. Your database administrator must create this database before 
you install the ezCallerID application. If you currently are using an Oracle database, there is no 
need to change databases. ezCallerID 2.0 will work with your previous data. 

Introduction

Note: Throughout this chapter we refer to two ezCallerID Oracle databases. You can give these 
databases any alphanumeric eight-letter name you want. We will use the default ezCallerID 
application names (CNAM and CNSECDB) provided in the DSET installation script.

ezCallerID Oracle Databases

There will be two Oracle databases created.

• CNAM—used for storing CNAM documents.

• CNSECDB—used for storing user ID accounts, passwords, and privileges assigned to
user ID by the ezCallerID System Administrator.

Storage Space Estimation

The CNSECDB (Security Agent) Oracle Database requires an initial size of 10 Mb of disk 
space with an incremental increase of 10 Mb. This database will require more storage on
large number of User IDs are defined.

The CNAM (Document) Oracle Database will grow according to the volume of CNAM orde
and messages used by the customer. Use Table 2-2 to estimate the amount of disk spac
company needs to accommodate the projected volume of ezCallerID orders.
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The table creation for this table includes a start size of 250 Mb and an increment of 10 Mb as 
needed. The retention period of the documents in the database determines its ability to reuse 
disk space. Old documents can be removed from the database and archived to backup media.

(Consult Chapter 5, “Preventative Maintenence” section. See INSERT CROSS REFERE

Overview - Creating Oracle DSET ezCallerID Databases

Table 2-2: ezCallerID Oracle CNAM Database Size Estimation

Number of 
Orders per Month

CNAM Database 
Tablespace Required 

per Month

CNAM Database 
Tablespace Required 

per year

5,000 2 Mb 24 Mb

10,000 4 Mb 48 Mb

20,0000 8 Mb 96 Mb

Table 2-3: ezCallerID Oracle Database Creation Steps  (1 of 2)

Check
here...

Step Page Once You Have Performed this Step

❏ A 2-9 Login and source Oracle profile with needed environment variables.

❏ B 2-10 Create UNIX directories for each database mount point.

❏
C 2-10

Create UNIX directories to hold other Oracle database instance administration
files.

❏
D 2-11

Copy and edit initialization and configuration files to use for the ezCallerID 
databases.

❏
E 2-12

Create links from the configuration and initialization files to the Oracle 
administration home directory.

❏ F 2-12 Set-up some SQL scripts to create the actual space allocations for the databa

❏ G 2-13 Run the Oracle scripts to create the CNAM and CNSECDB table structures.

❏ H 2-14 Mount the ezCallerID the CNAM and CNSECDB Oracle databases.

❏ I 2-14 Create a DSET Product DBA User ID.
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A - Define Environment Variables

1. Login as the Database Administrator at your company site with the Oracle User ID.

To make configuring the Oracle DSET application databases CNAM and CNSECDB easy, we 
need to define several UNIX variables to correspond to the key Oracle directory pathnames.

Note: Define each of the UNIX environment variables in Table 2-4 to correspond to the Oracle file 
directory structure used at your company.

❏ J 2-15 Set-up the Oracle Communications Network for the two databases

Table 2-4: Variables that Define Oracle Directory Pathnames

Environment
Variable Name

Pathname (an example) Description

$ORACLE_MOUNT /export/u02/oracle/data Parent directory for Oracle data files.

$ORACLE_HOME /export/u02/oracle/app/
oracle/product/8.0.5

Oracle’s installed home directory.

$ORACLE_TOP /export/u02/oracle/app/
oracle/admin

Parent directory for defining Oracle 
database administration files

$ORACLE_LISTENER /export/u02/oracle/app/
oracle/product/8.0.5/
network/admin

Directory with listener.ora, 
tnsnames.ora, and sqlnet.log

$ORACLE_USER_HOME /var/home/oracle Oracle User ID Home DIrectory

$ORACLE_DSET_SQL $DP_DIR/cnam/schema
(See Table 2-7)

Oracle SQL scripts to create databases, 
insert table schema, and perform 
maintenance operations.

Table 2-3: ezCallerID Oracle Database Creation Steps  (2 of 2)

Check
here...

Step Page Once You Have Performed this Step
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2. Type the following UNIX commands with a text editor to define the environment 
variables:

export ORACLE_MOUNT=/export/u02/oracle/data
export ORACLE_HOME=/export/u02/oracle/app/oracle/
product/8.0.5
export ORACLE_LISTENER=/export/u02/oracle/app/oracle/
product/8.0.5/network/admin
export ORACLE_TOP=/export/u02/oracle/app/oracle/admin
export ORACLE_USER_HOME=/var/home/oracle
export ORACLE_DSET_SQL=$DP_DIR/cnam/schemas

Save the commands as a “profile” file, “source” the profile, and use these variables as pa
the Oracle database creation procedures.

B - Create Directories for Database Mount Points

Create the CNAM and CNSECDB database Name directories at the Oracle mount points.

3. Change to the appropriate directory to define the Oracle Database DATA files.
cd $ORACLE_MOUNT

4. For the CNAM document database:
mkdir oracle1/oradata/CNAM
mkdir oracle2/oradata/CNAM
mkdir oracle3/oradata/CNAM

5. For the CNSECDB Security Agent database:
mkdir oracle1/oradata/CNSECDB
mkdir oracle2/oradata/CNSECDB
mkdir oracle3/oradata/CNSECDB

C - Create Admin Directories for Oracle Databases

6. Create the top-level Oracle administration directories.
mkdir $ORACLE_TOP/CNAM
mkdir $ORACLE_TOP/CNSECDB
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7. Create Oracle administration sudirectories for the CNAM document database.
cd $ORACLE_TOP/CNAM
mkdir bdump cdump create pfile udump

8. Create Oracle administration sudirectories for the CNSECDB security agent database.
cd $ORACLE_TOP/CNSECDB
mkdir bdump cdump create pfile udump

D - Build Initialization and Configuration Files

Take a standard Oracle database configuration file, plus an initialization file, and copy the files 
to the correct Oracle administration file directories:

9. cd $ORACLE_TOP/CNAM/pfile
cp example_config.ora configCNAM.ora
cp example_init.ora initCNAM.ora

10. Edit the configCNAM.ora and insert the document database name CNAM into each 
appropriate portion of the directory pathnames for “control” files and “dump” files. Make 
sure to change the line with the information: db_name = CNAM.

11. Edit the initCNAM.ora and insert the document database name CNAM into the 
appropriate parts of the “ifile” directory pathname. Change the names of the rollback 
segments to - (cnamdbrb1,cnamdbrb2,cnamdbrb3,cnamdbrb4).

12. cd $ORACLE_TOP/CNSECDB/pfile
cp example_config.ora configCNSECDB.ora
cp example_init.ora initCNSECDB.ora

13. Edit the configCNSECDB.ora and insert the Security Agent database name 
CNSECDB into each appropriate portion of the directory pathnames for “control” files 
and “dump” files. Make sure to change the line with the information:
db_name = CNSECDB.

14. Edit the initCNSECDB.ora and insert the Security Agent database name CNSECDB 
into the appropriate parts of the “ifile” directory pathname. Change the names of the
rollback segments to - (cnsecdbrb1, 
cnsecdbrb2,cnsecdbrb3,cnsecdbrb4).
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E - Create Links for Initialization and Configuration Files

You are now going to create symbolic links from an Oracle Home directory location 
($ORACLE_HOME/dbs) to the actual CNAM/CNSECDB initialization and configuration files 
($ORACLE_TOP/CNAM/pfile and $ORACLE_TOP/CNSECDB/pfile).

15. Create symbolic links for the CNAM document database:

cd $ORACLE_TOP/CNAM/pfile
ln -fs initCNAM.ora $ORACLE_HOME/dbs
ln -fs configCNAM.ora $ORACLE_HOME/dbs

16. Create symbolic links for the CNSECDB security agent database:

cd $ORACLE_TOP/CNSECDB/pfile
ln -fs initCNSECDB.ora $ORACLE_HOME/dbs
ln -fs configCNSECDB.ora $ORACLE_HOME/dbs

F - Create Scripts to Allocate Database Space

Now you will create the Oracle scripts to allocate tablespace (disk space) for each of the major 
files that makeup the CNAM and CNSECDB databases. The example scripts you use are 
provided by DSET within the installation product subdirectory.

Note: The example Oracle database scripts o_create.sql and o_crSec.sql are found in the 
product subdirectory defined by the pathname $DP_DIR/cnam/schema and the 
environment variable $ORACLE_DSET_SQL. This directory also contains SQL 
scripts to register (establish tables and organization) database schemas and perform other 
Oracle maintenance operations.

CAUTION

On the UNIX links command (ln), use the -f option only if you do not want any 
warning about overwriting an existing link.
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17. Create the Oracle script for the CNAM document database from a template.

cd $ORACLE_USER_HOME/SQL
cp $ORACLE_DSET_SQL/o_create.sql o_crCnam.sql

18. Use a UNIX text editor and make changes in the o_crCnam.sql script.

Replace IGPDB with CNAM for the database creation log: crdb.log
Replace IGPDB with CNAM for the database initialization file: initCNAM.ora
Replace IGPDB with CNAM on the “create” database SQL statement
Insert the statement “character set WE8ISO8859P1;”
Replace rb_temp with cnamdbrb_temp for the rollback segments
Change the rollback segment names from (rb1, rb2, rb3, rb4) to (cnamdbrb1, 
cnamdbrb2, cnamdbrb3, cnamdbrb4)
Replace IGPDB with CNAM anywhere in the directory pathnames throughout the scri

19. Create the Oracle script for the CNSECDB document database from a template.

cp $ORACLE_DSET_SQL/o_crSec.sql o_crCnSecdb.sql

20. Use a UNIX text editor and make changes in the o_crCnSecdb.sql script.

Replace SECDB with CNSECDB for the database creation log: crdb.log
Replace SECDB with CNSECDB for the database initialization file: 
initCNSECDB.ora
Replace SECDB with CNSECDB on the “create” database SQL statement
Insert the statement “character set WE8ISO8859P1;”
Replace secrb_temp with cnsecdbrb_temp for the rollback segments
Change the rollback segment names from (rb11, rb12, rb13, rb14) to 
(cnsecdbrb1, cnsecdbrb2, cnsecdbrb3, cnsecdbrb4)
Replace SECDB with CNSECDB anywhere in the directory pathnames throughout the
script.

G - Run CNAM and CNSECDB Table Creation Scripts

Run the two scripts you created (see "F - Create Scripts to Allocate Database Space" on
page 2-12).
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21. Run the CNAM and CNSECDB database creation scripts:

login as the Oracle user
% svrmgrl
connect internal
@$HOME/SQL/o_crCnam.sql
@$HOME/SQL/o_crCnSecdb.sql
quit

H- Mount the Databases

22. Mount the CNAM database with the SQL*PLUS commands after this UNIX command:

export ORACLE_SID=CNAM
login as the Oracle user
% svrmgrl
connect internal
startup
quit

23. Mount the CNSECDB database with the SQL*PLUS commands after this UNIX 
command:

export ORACLE_SID=CNSECDB
login as the Oracle user
% svrmgrl
connect internal
startup
quit

I - Create a DSET Product DBA User ID

The ezCallerID application must login with a database administration (dbadm) User ID and 
password (dbadm) to both Oracle databases to enforce security.
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To create the appropriate DSET application User ID, login to the Oracle software as the 
Oracle user and start the Server Manager: 

% svrmgrl
connect internal;
create user dbadm identified by dbadm;
grant all privileges to dbadm;
connect system/manager
@ORACLE_HOME/sqlplus/admin/pupbld.sql;
quit

Note: If the ezCallerID System Administrator has to manually start the Oracle databases or register 
the database schemes, they will need to use this user ID and password.

J - Set-up Oracle Network Communications

All the above database instances can exist in one machine holding all the CNAM documents 
and user security information. Remote DB access means the DSET ezCallerID gateway can 
run on a different machine than the machine holding the Oracle database instances. For this to 
happen, the machine on which the gateway instances are running should be configured so as to 
make the DB instances accessible through Oracle’s SQL*Net:

• tnsnames.ora - Transparent Network Substrate (TNS) Names

• listener.ora - Oracle Listener Client

These files should point to each of the DB instances created by the above naming conve
for example, CNAM and CNSECDB.

Edit the TNS Names File

Because Oracle SQL*Net V2 supports multiple communications protocols, we need to ed
TNS Names file to describe the (1) communications protocol and (2) connection descript
for each Oracle database instance. After we edit these files, we can refer to these two O
databases by their Oracle names CNAM and CNSECDB.

24. Change to the appropriate Oracle file directory.

cd $ORACLE_LISTENER
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25. Use a UNIX text editor to copy the following two sections from an existing portion of the 
tnsnames.ora file. We use the hostname gorda in this example for our machine.

CNAM =

  (DESCRIPTION =

    (ADDRESS = (PROTOCOL= TCP)(Host= gorda)(Port= 1521))

    (CONNECT_DATA = (SID = CNAM)) 

  )

26. In this portion of the tnsnames.ora file, we substitute the CNAM Oracle name and 
provide the file directory corresponding to the Oracle Home directory.

CNAM_BEQ =

  (DESCRIPTION =

    (ADDRESS = (PROTOCOL = BEQ)(PROGRAM = /export/u02/
oracle/app/oracle/product/8.0.5)

               (argv0 = oracleCNAM)

               (args = ’(DESCRIPTION = 
(LOCAL=YES)(ADDRESS=(PROTOCOL=BEQ)))’)

               (envs = ’ORACLE_HOME=/export/u02/oracle/
app/oracle/product/8.0.5,ORACLE_SID=CNAM’)

    )

  )

27. Repeat the previous two steps for the CNSECDB Security Agent Oracle database.

CNSECDB =

  (DESCRIPTION =

    (ADDRESS = (PROTOCOL= TCP)(Host= gorda)(Port= 1521))

    (CONNECT_DATA = (SID = CNSECDB))

  )

CNSECDB_BEQ =

  (DESCRIPTION =

    (ADDRESS = (PROTOCOL = BEQ)(PROGRAM = /export/u02/
oracle/app/oracle/product/8.0.5)
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               (argv0 = oracleCNSECDB)

               (args = ’(DESCRIPTION = 
(LOCAL=YES)(ADDRESS=(PROTOCOL=BEQ)))’)

               (envs = ’ORACLE_HOME=/export/u02/oracle/
app/oracle/product/8.0.5,ORACLE_SID=CNSECDB’)

    )

  )

Edit the Oracle Listener File

Each Oracle server on a network must contain a listener.ora file. This file lists the 
names and addresses of all of the TNS “listener” processes on the machine and the inst
they support.

28. Change to the Oracle file directory that contains the file listener.ora.

cd $ORACLE_LISTENER

29. Using a UNIX text editor, go to the Instance Definitions section denoted by the words:

SID_LIST_LISTENER =

30. Make two copies of an instance description and insert the two Oracle database ins
names, CNAM and CNSECDB.

(SID_DESC =

      (GLOBAL_DBNAME= gorda.dal.dset.com)

      (ORACLE_HOME= /export/u02/oracle/app/oracle/
product/8.0.5)

      (SID_NAME = CNAM)

)

    (SID_DESC =

      (GLOBAL_DBNAME= gorda.dal.dset.com)

      (ORACLE_HOME= /export/u02/oracle/app/oracle/product/
8.0.5)
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      (SID_NAME = CNSECDB)

    )

Start the Listener

31. First stop the Oracle “listener” and then restart the process.
login as the Oracle user
sqlplus dbadm/dbadm
lsnrctl stop 
lsnrctl start
exit

Configuration and Naming Conventions

These are some configuration issues and naming conventions that the customer needs 
follow, in order to create Oracle Database Instances for the CNAM (ezCallerID) gateway

Configuration

For ezCallerID version 2.0, DSET supports a single Service Center for one gateway. The
Account Number for the Service Center is 111111.

The Oracle databases include:

• One database instance for the CNAM IGP. This holds the documents.

• One database instance for the Security Agent. This holds the user accounts their pas
and privilege levels on Admin GUI operations.

This configuration will make sure that the documents for each ILEC get into the correspon
gateway's database instance.

Naming Conventions

The following convention allows easily identifiable database instances for each Gateway
instance. The name of the database instance should be no longer than 8 characters. Sin
is going to be one gateway instance per one ILEC, the name of the database instances 
ILEC specific.
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For example, let’s say the ILEC is Southwestern Bell. Use a three-character name to uniquely 
represent this ILEC, say SWB:

• The name of CNAM IGP database: CNAM

• The name of Security database: CNSECDB

The configuration files for this ILEC should be named:

• CNAM IGP: SWB.cnamIgp.cfg

• Security Agent: SWB.security.cfg

• CNAM CORBA Gateway:SWB.cnamgw.cfg

SWB.cnamIgp.cfg and SWB.security.cfg have variables that point to the 
database instance. The values of these variables should be set to:

In SWB.CNAMIgp.cfg the value of GEN_AGENT_DB_NAME should be CNAM.

In SWB.security.cfg the value of SEC_AGENT_DB_NAME should be CNSECDB.

Ongoing Tasks for Oracle Database Administrator

See Chapter 5, "Maintenance and Troubleshooting" on page 5-1, of this System 
Administration Manual for preventative maintenance tasks that the Oracle DBA must per

Role of DSET Installation Team

The DSET installation team will:

• Check that all third-party software has been installed prior to running the DSET ezCal
Application Installation script.

• Check that all Oracle ezCallerID databases are created.

• All Oracle ezCallerID databases are started and the Oracle LISTNER software is running.

• The Orbix Daemon is running.

• Run the ezCallerID application installation script.

• Start the ezCallerID gateway processes and verify they are running.
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• Use TBS software or a Web Browser (stand-alone GUI) to submit CNAM orders to th
ILEC.

• Examine the Activity and Trace logs to validate proper software operation.

• Arrange for dial-up access for DSET customer support personnel.

• Plan transition to using transfer protocols to send CNAM orders to a service center.

Last-minute Oracle/CORBA Preparations

During the installation, the installation script will ask if you will use an Oracle database to
store documents and perform security. Answer appropriately and configure the ezCallerI
system for your company.

During the installation, the script will automatically attempt to register the schemas for the
Oracle databases CNAM and CNSECDB you created. To make sure this goes smoothly,

1. Start the CNAM and CNSECDB Oracle databases (See "H- Mount the Databases" on 
page 2-14.)

2. Start the Oracle LISTENER software (see "Start the Listener" on page 2-18) so the 
ezCallerID Application Installation Script can successfully register the schemas.

3. Use these commands to check that the two ezCallerID databases can be successfu
accessed by the gateway application:

login as the Oracle user
sqlplus dbadm/dbadm@CNAM
sqlplus dbadm/dbadm@CNSECDB

Refer to Chapter 5, Maintenance and Troubleshooting, to determine what actions to take
Oracle ezCallerID database is not performing correctly.
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4. Test to see if the Orbix software that controls the CORBA process daemon is running:

ps -ef|grep orbix

You should see a response similar to this next line where cnam is the user ID, 4893 is 
the process ID that identifies Orbix, and 16:55:56 is the current time.

root   307     1  0   Oct 26 ?        0:12 /opt/iona/
OrbixMT_2.3c/bin/orbixd
cnam  4893  4877  0 16:55:56 pts/11   0:00 grep orbix

Refer to Chapter 5, Maintenance and Troubleshooting, to determine what actionsare needed 
when the CORBA software is not functioning.
November 15, 1999 1091-B DRAFT 2-21



Installing ezCallerID ezCallerID System Administration Manual
Prepare Basic DSET Environment

Steps to Define Basic DSET Environment

To set-up the Basic DSET environment you must:

1. Determine the third-party software information needed for ezCallerID Installation.

2. Create a UNIX user ID with sufficient “superuser” authority. DSET recommends that 
you use the name “CNAM”.

Table 2-5: ezCallerID Basic DSET Environment

Check here... Once You Have Performed

❏ [Integrated Configuration only] If you intend to use the MetaSolv Telecom 
Business Solution™ (TBS) application, you must install TBS v4.0.1 software. The 
software requires 80 Mb of hard disk space

❏ [Integrated Configuration only] You need to install Orbix™ v2.3.c from IONA 
Technologies PLC. Orbix™ v2.3.c requires 70 Mb of hard disk space.

❏ Create a new ezCallerID System Administrator User ID for your UNIX system.
We recommend the User ID of “CNAM”.

❏ Ensure that these UNIX commands are available to the “CNAM” User ID profile:
• rm—Delete files
• tar—Copy files from tape
• df—Determine amount of disk space available
• awk—Pattern matching program
• tail—Extract information from file’s records
• fgrep—Find literal match to string in files
• hostid—Get hexadecimal number of host server
• chown—Change file ownership
• chgrp—Change file ownership to new group
• hostname—Determine name of host machine
• ping—Determine the TCP/IP address of machines on this network

❏ Determine the exact directory pathname where to install the ezCallerID. The 
UNIX file directory should be empty. See Figure 2-2 to better understand the file 
directory structure.
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3. Create the ezCallerID home file directory.

4. Copy the ezCallerID application from the distribution media (tape, CD-ROM, etc.)

5. Run the script that checks and defines the “standard” DSET product environment.

Determine Information Needed for ezCallerID Installation

If you installed any third-party software, you will be asked to provide (1) home directory 
names, (2) process names, or (3) database instance identifiers to the ezCallerID installa
script.

There are two possible installation configurations for the ezCallerID application:

• Standalone GUI - Use a persistent Oracle database to store large numbers of ezCalle
customer orders with standalone Java-based GUI software.

• Integrated - Use an OSS/CORBA/GUI interface to permit a large number of service 
representatives to create customer orders and store them in an Oracle database.

Define the ezCallerID System Administrator User ID

1. Create the UNIX user ID CNAM with “super user” authority.

2. Use the UNIX cd command to move to the CNAM user ID home directory.

Table 2-6: Third-party Information for ezCallerID Installation Script

Information Response (default value)

Oracle Home Directory Path

Oracle ezCallerID Document Database Name CNAM

Oracle Security Agent Database Name CNSECDB

[CORBA/OSS Integration]
IONA Orbix Home Directory Path
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3. Ensure that these UNIX commands work for the CNAM user ID:

rm—Delete files

tar—Copy files from installation tape

df—Determine amount of disk space available

awk—Pattern matching program

tail—Extract information from file’s records

fgrep—Find literal match to string in files

hostid—Get hexadecimal number of host server

chown—Change file ownership

chgrp—Change file ownership to new group

hostname—Determine name of host machine

ping—Determine the TCP/IP address of machines on this network

Create the ezCallerID Installation Directory

1. Use the UNIX cd command to move to the Installation parent directory (see Figure 2
of the ezCallerID application.

2. Create the CNAM Version 2.0 home directory by typing the command:

mkdir CNAM2.0

DSET Application File Directories

To understand where all the software components of a DSET application will be installed
need to understand the recommended UNIX file directory structure. The high-level 
organization is useful for completing the ezCallerID application installation. Knowing whe
the application scripts and log files reside will be useful when you perform daily maintena
operations and troubleshooting.

This figure shows an example directory structure that illustrates the difference betw
the Installation Directory, the Product Directory, and the Product Subdirectory.
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Figure 2-1: Example DSET UNIX Product Directory Structure

High-level Directory Organization

DSET products have seven Product Subdirectories located under the application’s home
directory. If the product directory was defined as cnam, the resultant subdirectories would be

Table 2-7: ezCallerID Product Subdirectories

Product Subdirectory 
Names

Contents

/cnam/bin Software executables that make-up the ezCallerID product.

/cnam/config
Security, IGP, and gateway configuration files. There is often a 
generic set of files and a set of files for a specific trading partner. 
The application startup script also resides in this directory.

/cnam/d-dir Software executables that support the ezCallerID product.

/cnam/DATA Stores CNAM documents in UNIX File System

/cnam/etc Provides list of files copied to disk during this installation.

/cnam/schema
Oracle SQL scripts that create DSET databases, register the 
ezCallerID database schema, and perform database 
maintenance functions.

/cnam/www
Contains the stand-alone Java GUI that works with your Web 
Browser and the troubleshooting logs need to diagnose 
problems with the application, gateway, or security system.

/CNAM2.0/cnam/bin/libCNAMbeh.so
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Application Processes and Scripts

Subdirectories /bin and /d-dir contain the DSET ezCallerID application processes. You 
will use the /bin subdirectory to manually start and stop the ezCallerID application.

Configuration Files

These files contain the gatway, application, and security configuration set-up by the ezCallerID 
installation script for a specific trading partner (ILEC designated by XXX):

– XXX.cnamgw.cfg—ezCallerID gateway configuration file.

– XXX.cnamIgp.cfg—Defines how and where ezCallerID documents are stored 
the IGP and the names/IDs used to communicate with the regional NPAC center.

– XXX.security.cfg—Defines what format and SAP IDs are used to implemen
the ezCallerID internal security agent.

CNAM Documents, Errors, and Notification Messages

The /DATA subdirectory contains the CNAM documents, errors, and supporting files.

Database Schemas

The /schema subdirectory contains SQL scripts needed to define the schemas for the 
CNAM document and security databases. Other scripts register the database schemas (
tables and fields) and perform maintenance functions.

Logs

Each of the ezCallerID processes read a separate configuration file to specify the actual
directory where Logs are created. Figure 2-2 shows the standard directory structure for t
logs. This is consistent with the LOG_DIR parameter specified in the configuration files of th
ezCallerID processes.
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Figure 2-2: Log Directory Structure

The trading partner log subdirectories /cnamgw, /cnamIgp, and /Security contain 
CNAM document and software actions the System Administrator can use to determine that the 
ezCallerID application is functioning properly.

Copy ezCallerID from Distribution Media

1. Mount the DSET installation TAR tape or CD-ROM.

2. Use the cd command to position yourself at the Installation Directory for the ezCallerID 
application.

3. Starting at the top-level directory where ezCallerID will be installed, retrieve the 
application files from tape using the UNIX command:

tar xvf deviceName

Example: tar xvf /dev/rmt/1

(If the tape drive number is different than 1, use the appropriate number.)

Web Server Root Directory

CNAM Log Root Directory

cnamgw cnamIgp Security

Trading
Partner 2

Trading
Partner 3

Trading
Partner 1

. . . . . .
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4. The terminal console should display the list of files copied to the ezCallerID home file 
directory:

Run the installDSET Script

5. Verify the PATH environment variable includes the path to the installation files.

echo $PATH

6. Change the permissions on the two ezCallerID installation script files:

chmod 755 installDSET installCNAM

7. Run the first installation script.

installDSET cnam installCNAM

8. Immediately you receive a set of installation information and a request that asks if you 
want to proceed with the installation.

distList list of files that are in the DSET.tar.Z file

cnam.DSET.tar.Z Contains the ezCallerID application software.

installDSET
Script that sets up DSET’s product environment and verifies 
the system is ready for installing the ezCallerID before 
executing the installCNAM script.

installCNAM
Script that does the actual installation of the ezCallerID 
application.

cnam_sm.pdf ezCallerID System Administration Manual in PDF format

cnam_um.pdf ezCallerID User Manual in PDF Format
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Figure 2-3: Initial Installation Instructions

9. If you’ve completed the pre-installation checklist, installed all required third-party 
software, have at least 150 Mb of free hard disk space, and have any required Orac
databases set up, answer Y at the prompt.

This script will take approximately 5 minutes to complete.

If you typed a Y and do not have at least 20 Mb of free disk space for the installation,
prompt displays:

Free disk space in ./ is less than 20MB,
installation may fail.

Proceed (y/n)? 

If you proceed without making 20 Mb of free disk space available, the installation m
fail. To ensure correct installation, type N and remove files to free up the required d
space, then proceed with Step 7 again.

This installation should be performed by a super user. 
To install DSET products, you need to select a 
directory to install it. This directory should be 
empty.

Also, you need to assign a DSET administrator from the 
logins on this system. You will be prompted for this 
DSET administrator login name later during the 
installation.
The following shell utilities must be in your path: rm, 
tar, df, awk, tail, fgrep, hostid, chown, chgrp, 
hostname

Please make sure you are prepared for all these 
requirements before you proceed with the installation. 
If you decide to go on, please type ’y’ at the prompt 
now, otherwise type ’n’ to cancel this installation and 
start all over later.
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10. The installation script displays:

Installation of DSET product starts ...
Uncompressing the compressed tar file ... 
Extracting files from tar file ... 
Verifying distribution ...
Installed files have been verified.

11. When prompted, type the ezCallerID System Administrator User ID:

DSET-Admin-Login-Name(root)

Important!: Do NOT use the UNIX user ID root, use the ezCallerID System Administrator User ID 
(for example, CNAM) you created before installation.

12. The installation script continues to display the messages:

changing the file and directory ownership ...
Installation of DSET Product is complete.

The DSET administrator needs to refer to the 
administration guide to set up the DSET environment 
before it can be used.

An example login profile is created as: 
/<ezCallerID Home Directory Name>/profile.

Note: The login profile pathname is $DP_DIR/profile.

The initial portion of the DSET product installation script is complete.

What the installDSET Script Does

The installDSET script performs serveral vital checks of the UNIX environment to 
determine if you are ready to install the ezCallerID product:

• It removes any installation files left from previous ezCallerID software installations.

• Verifies that the ezCallerID home file directory is empty.
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• Ensures that the ezCallerID directories have 20 Mb of available disk space.

• Verifies that the ezCallerID System Administrator user ID (for example, CNAM) has super 
user status and the user ID’s password exists.

• Unpacks the cnam.DSET.tar.Z file and checks to see that all files defined in the 
distList file (installation file list) exist in the ezCallerID file directories.

• Asks the user to supply the ezCallerID System Administrator User ID (for example, CNAM) 
and verifies their administrative authority.

• Creates standard DSET system directories and integrates the supplied System 
Administrator user ID into the product’s internal security.

• Gives ownship of all installed ezCallerID application files to the System Administrator

• Creates a sample profile file that must be supplied to all ezCallerID users.

• Removes any temporary files used during this phase of the installation.
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Install the ezCallerID Application

Before you perform the third major section of the installation procedure, you need to have the 
information required to answer all the questions asked by the ezCallerID application install 
script. You will be prompted for installation options, database names, process names, and 
communication port numbers.

Port Numbers

If you know that you already have existing DSET applications running on the UNIX system 
and you want to install ezCallerID, contact the other DSET application System Administrators 
and determine what port numbers were assigned to each application

Note: The HTTP Daemon port number is the value used to access this DSET application with the 
Web Browser. (See "J - Start ezCallerID Web Browser [Standalone GUI]" on page 2-54.)

CAUTION

Once you have decided upon the ezCallerID port numbers to use, be careful that other DSET 

applications such as ez911 and ezCallingCard are assigned unique TCP/IP, HTTP daemon, 

and Security Agent port numbers.

Table 2-8: An Example of DSET Product Port Numbers

DSET
Application

Security
Agent

HTTP
Daemon

TCP/IP
Application

ez911 6500 6501 6502

ezCallerID 6600 6601 6602

ezCallingCard 6700 6701 6702
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Reponses for ezCallerID Installation Script

Table 2-9: ezCallerID Application Installation Responses

Response Specific Installation Information (Installation Step)

Oracle software and databases ready (Step 2 on page 2-34)

CORBA/OSS or Standalone GUI (Step 3 on page 2-35)

ezCallerID gateway process name (Step 4 on page 2-35)

ezCallerID Security Agent process name (Step 6 on page 2-36)

ILEC Designation (Step 8 on page 2-36)

[CORBA/OSS Only] Orbix CORBA software home directory pathname
(Step 11 on page 2-38)

Oracle server v8.0.5 software home directory pathname
(Step 12 on page 2-38)

TCP/IP port number of the ezCallerID Gateway..
(Step 14 on page 2-39)
Note: Default TCP/IP port number is 9999. 

Security Agent port number for the ezCallerIDinstallation.
(Step 15 on page 2-39)
Note: Security Agent port number defaults to 1111. 

[CORBA/OSS only] Remote CORBA Host Name
(Step 16 on page 2-39)

[CORBA/OSS only] Remote CORBA Server Name
(Step 18 on page 2-40)

Oracle ezCallerID Gateway Database Name 
(Step 21 on page 2-41)

Oracle Security Agent Database Name
(Step 23 on page 2-42)

[1Sometimes] TCP/IP address of the ezCallerID Gateway Host
(Step 25 on page 2-42)

HTTP daemon port number for the ezCallerID installation.
(Step 27 on page 2-43)
Note: HTTP daemon port number defaults to 7117.
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Run the ezCallerID Installation Script

1. Type the command:

./installCNAM

The ezCallerID installation script responds by displaying:

####################################################################
#      START CUSTOMIZING ezCallerID CONFIGURATION                                       #
#################################################################

Oracle Software and Databases Installed

The script asks if you have the Oracle 8 Database Software: 

The ezCaller Gateway installation needs ORACLE 
database software to store the customer orders.

Your Oracle DBA must also create two databases before
you use the ezCallerID Gateway.

Do you have Oracle 8 software and databases installed 
for ezCallerID gateway?(y/n) ... 

2. Type Y to confirm that you have the Oracle 8 Enterprise Server Software (see "Oracle 
Server Software" on page 2-5) plus you have created the two DSET Oracle databases 
CNAM and CNSECDB (see "Overview - Creating Oracle DSET ezCallerID Databases" on 
page 2-8) or type N to stop the ezCallerID application installation. You receive this 
message from the installation script:

Error: Need install the Oracle software and create the 
databases before you use ezCallerID Gateway.
EZCALLERID GATEWAY CONFIGURATION FAILED!

1. The ezCallerID Installation Script attempts to determine the name of the ezCallerID host UNIX machine. If it is unable to 
automatically determine the Host Name, the System Administrator is prompted for the TCP/IP address of the host.
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CORBA OSS or Standalone GUI to Create Orders

3. The script displays the CORBA/OSS or standalone GUI software question:

To receive ezCallerID (CNAM) orders, the ezCaller Gateway 
can communicate with a CORBA Operational Support System 
(OSS) or a standalone GUI.

* For the CORBA OSS, you must have the MetaSolv TBS 
4.0.1 software and Orbix v2.3.c software installed to 
send orders to the ezCaller Gateway.

* If the CORBA software is not installed, DSET’s stand-
alone GUI can be used to send orders."

** IMPORTANT ** Contact your SYSTEM ADMINISTRATOR for 
the DSET GUI information.

Do you want to use intergrated GUI/CORBA/TBS OSS 
solution to create CNAM orders?(y/n) ... "

Type a Y if you have installed the Orbix™ v2.3.c software, MetaSolv’s TBS software
and want to use the integrated installation configuration.

Note: The ezCallerID installation script now creates temporary copies of key configuration files
will edited as you respond to questions in the upcoming installation steps.

Define ezCallerID Gateway Process Name

4. The script displays the prompt:

Type the ezCallerID gateway process name [cnamgw - 
default]:

The value in parenthesis is the default value. You must manually type the ezCallerID
gateway process name if you want to use a name other than the default.

CAUTION

The ezCallerID gateway process can not have the name cnamCorbaGw or 
cnamAsciiGw.
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5. Once you type the ezCallerID gateway process name, the installation script echoes your 
response and requests confirmation.

ezCallerID gateway process name is: cnamgw
CONFIRMATION: Is this process name correct?(y/n) ...  y

Type Y to confirm the process name or type N to return to the prompt in Step 4 on 
page 2-35.

Define ezCallerID Security Process Name

6. The script displays the prompt:

Type the security agent process name [secAgent - 
default]:

The value in parenthesis is the default value. You must manually type the Security Agent 
process name if you want to use a name other than the default.

7. Once you choose the security agent process name, the installation script echoes your 
response and requests confirmation.

security agent process name is: SecAgent
CONFIRMATION: Is this security process name 
correct?(y/n) ...  y

Type Y to confirm the process name or type N to return to the prompt in Step 6 on 
page 2-36.

Define Trading Partner (ILEC)

8. The installation script next displays:

The ILEC_NAME identifies the name of an ILEC.
For example,
BAN may be used to identify - Bell Atlantic
SWB may be used to identify - Southwestern Bell

Type the ILEC name:  SWB

Type the ILEC designation you want to use. 
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9. Once you choose the ILEC designation, the installation script echoes your typed response 
and requests confirmation.

ILEC_NAME name you’ve typed is: SWB
CONFIRMATION: Is this ILEC name correct?(y/n) ...  y

Type Y to confirm the ILEC name or type N to return to the prompt in Step 8 on 
page 2-36.

Note: Figure 2-2 shows the UNIX directory structure created by the installation script, based upon 
the ILEC name (trading partner) specified. For example, the directory pathname for the 
ezCallerID logs that belong to an ILEC named SWB (Southwestern Bell) might look like:
 /<ezCallerID Install Directory>/cnam/www/cnam/log/SWB/...

Define the CORBA Software Home Directory

Important!: Contact your UNIX System Administrator for the IONA Orbix directory path.

10. If you have chosen to configure the ezCallerID application to use the CORBA/OSS 
integrated configuration, the installation script displays the explanation:

Figure 2-4: Orbix Home Directory Instructions

Type the home directory for the CORBA software produced by IONA Technologies PLC. 
You must manually type the home directory name.

IONA is a company which provides a CORBA application
-Orbix(R). To start the ezCallerID (CNAM) gateway,
you need provide the UNIX pathname of the top-level
directory for the IONA software package. Often, the
following directories are used for IONA software:

  *  /tools/iona   (default for DSET installation)
  *  /opt/iona     or
  *  /opt/iona/Orbix.X.X (where X.X is software release)

Type the complete path to the IONA Orbix top-level
directory (/tools/iona):
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11. Once you type the Orbix home directory, the installation script echoes your response and 
requests confirmation.

Path to IONA home is: /opt/iona/OrbixMT_2.3c
CONFIRMATION: is this correct pathname?(y/n) ...y

Type Y to confirm the Orbix software home directory pathname or type N to return to the 
prompt in Step 10 on page 2-37.

Define the Oracle Software Home Directory

Important!: Contact your Oracle Database Administrator for the Oracle directory pathname.

12. For the Oracle database to store CNAM documents and implement security, the 
installation script displays:

Type the complete pathname to the Oracle Database
home directory.

Example:/tools/oracle/app/oracle/product/8.0.5

Oracle home directory:

Type the home directory for the Oracle server software. You must manually type the 
home directory name.

13. Once you type the Oracle home directory, the installation script echoes your response and 
requests confirmation.

Path to oracle home directory is: /export/u02/oracle/
app/oracle/product/8.0.5
CONFIRMATION: is this Oracle pathname correct?(y/n) 

Type Y to confirm the Oracle software home directory pathname or type N to return to 
the prompt in Step 12 on page 2-38.
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TCP/IP Gateway and Security Agent Port Numbers

14. The ezCallerID (CNAM) server port number identifies the TCP/IP port for the gateway.  
This is the port with which the ezCallerID System Administration GUI communicates 
with the ezCallerID gateway. The server port number should be greater than 1024 and 
less than 99999.

Type the ezCallerID (CNAM) Gateway port number[9999 - 
default]:

Type the gateway port number for the ezCallerID application. The value in parenthesis is 
a sample value, not a default value. You must manually type in a port number. Refer to 
the guidelines in "Port Numbers" on page 2-32. If the port number is within the range of 
(1025 to 99998), then the installation script echoes the gateway port number.

Gateway Server TCP/IP port number is: 6600

15. The ezCallerID (CNAM) security port number identifies the TCP/IP port where the 
Security Agent communicates with the gateway. The security port number should be 
greater than 1024 and less than 99999.

Type the security agent port number[1111 - default]:

Type the security agent port number for the ezCallerID application. The value in 
parenthesis is a sample value, not a default value. You must manually type in a port 
number. Refer to the guidelines in "Port Numbers" on page 2-32. If the port number is 
within the range of (1025 to 99998), then the installation script echoes the security port 
number.

Security TCP/IP port number is: 6601

CORBA Installation Information [CORBA/OSS only]

16. If you have chosen to use the Operational Support System (OSS) with CORBA instead of 
the standalone GUI, you must identify the:

> CORBA host name
> Remote CORBA server name
> Gateway Waiting Period before extracting CNAM orders from OSS.

The installation script prompts you with:

The remote CORBA hostname is the machine on which the
OSS CORBA server is running.

Type the remote CORBA hostname:
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Type the name of the host machine. You must manually type the name. There is no 
default.

17. Once you type the name of the host machine, the installation script echoes your response 
and requests confirmation.

Remote CORBA hostname is: paso
CONFIRMATION: Is this CORBA hostname correct?(y/n)

Type Y to confirm the CORBA host name or type N to return to the prompt in Step 16 on 
page 2-39.

18. Now you must identify the remote server name. The installation script prompts you with:

Remote CORBA server name is the name of the OSS API 
server

Type the remote corba server name[PSRANCILLARYSERVER - 
default]:

Type the name of the remote CORBA server.

19. Once you type the remote CORBA server name, the installation script echoes your 
response and requests confirmation.

Remote CORBA server name is: PSRANCILLARYSERVER
CONFIRMATION: is this correct?(y/n)

Type Y to confirm the remote CORBA server name or type N to return to the prompt in 
Step 18 on page 2-40.

20. Now you must select the amount of time the ezCallerID gateway waits before it extracts a 
CNAM order from the OSS. The installation script prompts you with:

The ezCallerID gateway waiting period is the time the 
gateway waits before extracting an order from the OSS. 
The default value is 24 hours, which equals 86400 
seconds.

Type the waiting period in seconds [86400 - default]:

DSET suggests a waiting period of 86400 seconds (once per day). Type the number of 
seconds you want the ezCallerID gateway to wait before extracting a CNAM order from 
the OSS.
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Note: You may want to set the waiting period to a shorter interval (1200 seconds—20 minutes) 
during the initial testing period. Later, you can increase the waiting period by modifying t
CNAM gateway configuration file.

ezCallerID Orders and Security Oracle Database Names

Important!: Contact your UNIX System Administrator for the Oracle database name.

21. When using the Oracle server v8.0.5 to store CNAM orders (documents) information
perform security monitoring, you must now provide the installation procedure with th
names of the Oracle Document Database and Security Agent Database

The ezCallerID database is the database for customer 
order storage.

Type the ezCallerID Oracle db name (CNAM - default):

The value in parenthesis is the default value. You must manually type the Oracle 
Document Database name if you want to use a name other than the default.

22. Once you choose the ezCallerID Document Database name, the installation script e
your response and requests confirmation.

ezCallerID Oracle db name is: CNAM
CONFIRMATION: Is this Oracle db name correct?(y/n) ...

Type Y to confirm the Oracle Document Database name or type N to return to the prompt 
in Step 21 on page 2-41.

CAUTION

Modify a DSET application configuration file only under the direction of DSET Customer
Service personnel.

To modify the CNAM gateway configuration file (/config/<ILEC>.cnamgw.cfg), 
use a UNIX text editor (such as vi) and change the value in the line denoted by: 
#Time period for the gateway extract the data from OSS
GW_SLEEP_TIME=3000
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23. You must now provide the installation procedure with the Security Agent Database name.

The ezcallerID security database is the database that 
contains the User IDs of the System Administrators and 
Operations personnel. This database continues to 
monitor all users throughout their sessions.

Type the ezCallerID Security db name (CNSECB - 
default):

The value in parenthesis is the default value. You must manually type the Oracle 
Document Database name if you want to use a name other than the default.

24. Once you choose the ezCallerID Document Database name, the installation script echoes 
your response and requests confirmation.

ezCallerID Security db name is: CNSECDB
CONFIRMATION: Is this Security db name correct?(y/n)..

Type Y to confirm the Oracle Security Database name or type N to return to the prompt in 
Step 23 on page 2-42.

Host TCP/IP Address [Sometimes]

25. This step is only needed when the ezCallerID Installation Script can not automatically 
find the Host Name of the UNIX machine on which the DSET application is being 
installed. You are prompted with the text:

Enter the IP address of the cnam gateway host:

26. Once you type the TCP/IP address of this UNIX computer, the installation script echoes 
your response and requests confirmation.

The server host IP address is: 192.134.67.11
CONFIRMATION: is this correct?(y/n) ... 

Type Y to confirm the Host TCP/IP address or type N to return to the prompt in Step 25 
on page 2-42.
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Build the ezCallerID Home Page

During the next phase of the installation script, the ezCallerID application HTML Home 
document is created automatically. As a system administrator, this is the HTML file that your 
Operations personnel select when they access the ezCallerID application via the HTTP port 
number.

For example, if your host machine name is larry, the HTTP Daemon Port Number (see "HTTP 
Daemon Port Number" on page 2-43) is 6601, and the ILEC you are working with is 
Bell Atlantic North (designated as BAN), your operations personnel would:

Step A: Type the URL http://larry:6601 in Netscape Communicator (4.61 or later) or 
Internet Explorer (4.15 or later) to find the ezCallerID application.

Step B: Click the HTML document file name - main.BAN.html to start the ezCallerID 
application.

HTTP Daemon Port Number

27. The installation script needs to configure the Web Server startup file with the HTTP 
Daemon Port Number. The script prompts you with the text:

To communicate with the ezCallerID Gateway from outside 
world, you need to specify an HTTP port number. This 
port number, plus the hostname, permits you to connect 
to the ezCallerID gateway. Operations personnel will 
use Netscape Communicator (4.6 or later) or Internet 
Explorer (4.15 or later) to start the ezCallerId GUI.

This HTTP port number SHOULD BE greater than 1024 and 
less than 99999.

Type the ezCallerID HTTP port number[7777 - default]:

The value in parenthesis is the default value. You must type the HTTP Daemon Port 
Number name if you want to use a port number other than the default.

28. Once you choose the HTTP Daemon Port Number, the installation script echoes your 
response and requests confirmation.

ezCallerID HTTP port number is: 6601
CONFIRMATION: Is this HTTP port number correct?(y/n)...
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Type Y to confirm the HTTP Daemon Port Number or type N to return to the last portion 
of the prompt in Step 27 on page 2-43.

Finishing the ezCallerID Installation Script

You have finished providing all the information required by the ezCallerID application 
installation script. Depending upon the installation configuration chosen, OSS and/or Oracle 
Database, the installation script attempts to automatically:

• Register the CORBA/OSS processes with the Orbix CORBA daemon.

• Register the schemas for the two Oracle databases chosen during installation.

Registering Processes with Orbix Software [CORBA/OSS only]

During this phase of the installation the script registers the ezCallerID application proces
(gateway and interconnection gateway platform) with the Orbix software. You will see con
messages that begin with the words:

RUNNING C_SETUP ON ...

Defining Oracle Database Schemas

The ezCallerID Document Database and the Security Agent Database need to register t
database schema (structure of tables and procedures) with the Oracle software.

CAUTION

To register the Oracle Schemas, the two Oracle database instances must have been sta
the Oracle Listener process must be running. If these steps (see "H- Mount the Database
page 2-14) are not done prior to the ezCallerID installation, the two databases must be sta
and the schemas registered manually.
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When the database schemas are registered by the installation script, the console messages 
display as:

Explanation of registering Oracle schemas...

starting to register the CNAM database schema ...
PLEASE WAIT...

Register the ezCallerID gateway CNAM Oracle database
schema is done.

 

starting to register the CNSECDB database schema ...
PLEASE WAIT...

register the ezCallerID gateway security CNSECDB
Oracle database schema is done.

Great Job!

The final installation message is:

EZCALLERID GATEWAY HAS BEEN CONFIGURED SUCCESSFULLY!

followed by the post-installation instructions that are covered in the next section of this 
chapter.
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Post-installation Tasks

Once the ezCallerID installation script completes, you want to begin checking that all elements 
of the ezCallerID installation are working correctly.

Table 2-10: ezCallerID Post-Installation Steps  (1 of 2)

Check
here...

Step Page Once You Have Performed this Step

❏
A 2-47

“Source” the CNAM User ID profile so that all application and Oracle 
environmental variables are set correctly for steps C and D.

❏
B 2-47

Modify the ezCallerID System Administrator’s Korn Shell so that the DSET 
application environment variables are available.

❏

C 2-48

Ensure the DSET application environmental variables are set correctly:
$DP_DIR - your ezCallerID root directory where the software was installed
$D_DIR - base directory for the namemgr process to manage other processes
$IONA_HOME [CORBA/OSS only]

❏

D 2-49

Ensure the Oracle environmental variables are set correctly.
$ORACLE_HOME - installed home directory
$ORACLE_LISTENER - Oracle network communication files
$ORACLE_USER_HOME - Oracle’s home directory for the Oracle User ID.

❏
E 2-50

Verify library paths are set-up by checking for process dependencies with the UNIX 
ldd command.

❏ F 2-52 [CORBA/OSS only] Verify that the Orbix process daemon is running.

❏
G 2-52

Verify that the Oracle software and the ezCallerID Oracle databases CNAM and 
CNSECDB are ready for online transactions.

❏ H 2-53 Start the ezCallerID application using the ezCallerID startup script.

❏ I 2-53 Test to see that all ezCallerID application processes are running.

❏
J 2-54

Test to see if you can login to the ezCallerID application with your Web browser as 
the ezCallerID System Administrator.

❏ K 2-55 Set-up a Service Center and a DownStream Interface to test the application.

❏ L 2-56 Create one or more CNAM orders (documents).

❏
M 2-56

Examine the Activity and Trace logs to verify that CNAM orders (documents) 
passed through the ezCallerID gateway.
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em 
A- Source the Profile File 

As the ezCallerID installation script finishes, it provides you the following instructions:

Before starting the gateway, make sure you source the 
PROFILE in the ezCallerId gw home directory
(/ezConnect/home/cnam/cnam2.0.5/cnam).

1. This directory is in the product file directory (a subdirectory of the Installation 
Directory—see Figure 2-1). Type the following commands at the command prompt:

cd $DP_DIR/cnam
. ./profile (be sure there is blank space between the periods)

All the ezCallerID application, Oracle, and Orbix [CORBA/OSS only] environmental 
variables should be available to the application users.

B- Provide Variables to ezCallerID System Administrator

2. Locate the Korn Shell file $HOME/.kshrc in your UNIX home directory.

3. Using the vi text editor or other software to edit the file and add this line to the Syst
Administrator Korn Shell. This will make the ezCallerID application variables 
immediately available to the administrator:

.  <ezCallerID Installation Directory>/cnam/profile

4. Save the $HOME/.kshrc file.

❏
N 2-57

Create a backup tape/media of the ezCallerID gateway installation once it is fully 
functional.

❏

O 2-58
Provide remote dial-in capacity (user level authorization is fine) so DSET customer 
service personnel can access all tasks within the ezCallerID application 
directory.

Table 2-10: ezCallerID Post-Installation Steps  (2 of 2)

Check
here...

Step Page Once You Have Performed this Step
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ay 
ezCallerID Environment Variables

These are the key application and third-party environment variables. In the subsequent steps, 
you should display the contents of each variable to verify that it points to the correct UNIX file 
directory.

C - Validate ezCallerID Environment Variables

Echo the ezCallerID environment variables to ensure that they point to the correct UNIX file 
directories as defined for your company’s gateway.

Note: Make sure DP_DIR is set to directory path where ezCallerID installation scripts are located.
Ensure D_DIR is set to the directory path of the /d-dir subdirectory.

5. Typing the UNIX echo command for each application variable should list file 
directories corresponding to your company’s configuration for the ezCallerID gatew
application. An example response should look like:

Table 2-11: DSET ezCallerID Application Environment Variables

Variable Description

DP_DIR
The ezCallerID Gateway installation directory (see Figure 2-1). This is used by 
several application executable processes to read configuration files.

D_ DIR
The directory used as base by the namemgr process to maintain and keep 
track of ezCallerID Gateway processes.

LD_LIBRARY_PATH
The LD_LIBRARY_PATH should have pointers to the following software 
components: Oracle and IONA Orbix Libraries. 

IT_CONFIG_PATH The directory containing the CORBA software (Orbix) configuration files.

PATH

The directories to search for executables, libraries, etc. It should include 
$DP_DIR/cnam/bin and $D_DIR/bin so that it picks up the ezCallerID 
executables. If applicable, it should also include the binary libraries for the 
CORBA (Orbix) and Oracle software products.
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d for 
echo $DP_DIR

ezConnect/home/cnam/cnam2.0.6

echo $D_DIR

/ezConnect/home/cnam/cnam2.0.6/cnam/d-dir

echo $PATH

/ezConnect/home/cnam/cnam2.0.6/cnam/d-dir/bin:/
ezConnect/home/cnam/cnam2.0.6/cnam/bin:/usr/local/
bin:/usr/bin:/usr/sbin:/ezConnect/home/e911/tools:/
usr/ucb:/etc:/opt/iona/OrbixMT_2.3c/bin:/ezConnect/
home/cnam/bin:.:/opt/iona/OrbixMT_2.3c/bin:/export/
u02/oracle/app/oracle/product/8.0.5/bin

Note: The $PATH variable contains the pathnames to all application binary libraries, plus any Oracle 
or CORBA libraries required for your company’s configuration.

D - Validate DB and CORBA Environment Variables

6. Continue to echo the environmental variables specific to the software packages use
your DSET gateway configuration.

Note: The following environment variable values are examples only. The actual file directory 
pathnames are specific to your company and host machine.

echo $IONA_HOME

/opt/iona/OrbixMT_2.3c

echo $IT_CONFIG_PATH

/opt/iona/OrbixMT_2.3c/cfg

echo $LD_LIBRARY_PATH

/opt/iona/OrbixMT_2.3c/lib:/export/u02/oracle/app/
oracle/product/8.0.5/lib
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Note: Several of the Oracle environmental variables are developed to make creating your Oracle 
database CNAM and CNSECDB easier.

echo $ORACLE_MOUNT

/export/u02/oracle/data

echo $ORACLE_HOME

/export/u02/oracle/app/oracle/product/8.0.5

echo $ORACLE_TOP

/export/u02/oracle/app/oracle/admin

echo $ORACLE_LISTENER

/export/u02/oracle/app/oracle/product/8.0.5/network/
admin

echo $ORACLE_USER_HOME

/var/home/oracle

echo $ORACLE_DSET_SQL

ezConnect/home/cnam/cnam2.0.6/cnam/schema

E - Verify Library Paths for Processes 

Once all the environmental variables are correct, we need to make a quick check that key 
software processes can find all shared software library objects they need and the application 
has permissions to access all library files.

7. Switch to the bin product subdirectory (see Figure 2-2) and list all the dynamic 
dependencies (UNIX ldd command) or shared objects that would be loaded when the 
process file is executed.

cd $DP_DIR/cnam/bin
ldd secAgent 
ldd cnamgw
ldd cnamIgp             <--- may use Orbix CORBA library
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ldd thttpd
ldd startup
ldd ../d-dir/bin/namemgr

Figure 2-5 illustrates an example of the console output you see for each of the six 
ezCallerID application processes.

Figure 2-5: Example Console Output from the command - ldd cnamIgp

Note: For the processes cnamIgp and secAgent you should see the Oracle binary library listed. 
For the cnamgw gateway process, you should see the Orbix library if you are using the 
CORBA/OSS integrated configuration.

CAUTION

If any of the library pathnames are not found, ensure the Oracle and CORBA (Orbix) library 
directories are included for the $PATH variable in $DP_DIR/cnam/profile file. Check 
with the command—echo $PATH .

libdl.so.1 =>    /usr/lib/libdl.so.1
libsocket.so.1 =>        /usr/lib/libsocket.so.1
libnsl.so.1 =>   /usr/lib/libnsl.so.1
libelf.so.1 =>   /usr/lib/libelf.so.1
libclntsh.so.1.0 => /export/u02/oracle/app/oracle/
product/8.0.5/lib/libclntsh.so.1.0
libc.so.1 =>     /usr/lib/libc.so.1
libaio.so.1 =>   /usr/lib/libaio.so.1
libm.so.1 =>     /usr/lib/libm.so.1
libthread.so.1 =>        /usr/lib/libthread.so.1
libC.so.5 =>     /usr/lib/libC.so.5
libw.so.1 =>     /usr/lib/libw.so.1
libintl.so.1 =>  /usr/lib/libintl.so.1
libmp.so.1 =>    /usr/lib/libmp.so.1
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F - Verify CORBA Software [CORBA/OSS only]

8. Test to see if the CORBA software (Orbix) process daemon is running by using the UNIX 
command:

ps -ef|grep orbix

You should see a response similar to this next line where cnam is the user ID, 4893 is 
the process ID that identifies Orbix, and 16:55:56 is the current time.

root   307     1  0   Oct 26 ?        0:12 /opt/iona/
OrbixMT_2.3c/bin/orbixd
cnam  4893  4877  0 16:55:56 pts/11   0:00 grep orbix

G - Verify Oracle Databases are Started

9. Test that the Oracle ezCallerID databases are online by typing the commands:

ps -ef|grep ora|grep CNAM     or
ps -ef|grep ora|grep CNSECDB  

You should see a response similar to the following lines for the two Oracle databases 
CNAM and CNSECDB:

Figure 2-6: Example Console Output for Oracle Databases

oracle  4843  1  0 16:45:13 ?  3:06 oracleCNAM (LOCAL=NO)
oracle  1078  1  0 Oct 26 ?    0:11 ora_dbw0_CNAM
oracle  1076  1  0 Oct 26 ?    0:04 ora_pmon_CNAM
oracle  1080  1  0   Oct 26 ?  0:12 ora_lgwr_CNAM
oracle  1082  1  0   Oct 26 ?  2:40 ora_ckpt_CNAM
oracle  1084  1  0   Oct 26 ?  0:13 ora_smon_CNAM
oracle  1086  1  0   Oct 26 ?  0:02 ora_reco_CNAM

oracle  1095  1  0   Oct 26 ?  0:04 ora_pmon_CNSECDB
oracle  1097  1  0   Oct 26 ?  0:00 ora_dbw0_CNSECDB
oracle  1099  1  0   Oct 26 ?  0:02 ora_lgwr_CNSECDB
oracle  1101  1  0   Oct 26 ?  2:25 ora_ckpt_CNSECDB
oracle  1104  1  0   Oct 26 ?  0:14 ora_smon_CNSECDB
oracle  1106  1  0   Oct 26 ?  0:02 ora_reco_CNSECDB
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H - Starting the ezCallerID Gateway

10. To start the ezCallerID gateway, change the current directory to the ezCallerID 
subdirectory containing the ezCallerID process scripts:

cd $DP_DIR/cnam/bin

11. Type this command at the prompt: 

cnam start

You should see a response similar to these lines if the start command is successful.

Info : ./cnam invoked on pts/2 by cnam
Date : Mon Nov 1 19:04:30 CST 1999
Checking for environment variables
6640 started on gorda (pts/2) at Mon Nov 1 19:04:33 CST 
1999 by cnam

I - Test all ezCallerID Processes

12. Ensure all six processes, namemgr, thttpd, secAgent , startup, cnamIgp, 
and cnamgw are active.

13. Type the command at the console:

ps -ef | grep cnam

Note: You may see some “extra” processes that belong to the owner cnam, but these are the ones 
required for the ezCallerID gateway application to run.

cnam  7345  7343  0 19:32:58 pts/2    0:00 /ezConnect/
home/cnam/cnam2.0.6/cnam/d-dir/bin/namemgr
 <Name Manager>

cnam  7357  7343  0 19:33:08 pts/2    0:00 /ezConnect/
home/cnam/cnam2.0.6/cnam/bin/thttpd -p 6601 -d /
ezConnect/home/cnam/ 
<HTTP Daemon>
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cnam  7355  7343  1 19:33:08 pts/2    0:00 /ezConnect/
home/cnam/cnam2.0.6/cnam/bin/secAgent -p /ezConnect/
home/cnam/cnam2.
<Security Agent Process>

cnam  7343     1  0 19:32:58 pts/2    0:00 startup /
ezConnect/home/cnam/cnam2.0.6/cnam/config/
ILLUMINET.cnam.startup
<Startup Process>

cnam  7356  7343  1 19:33:08 pts/2    0:00 /ezConnect/
home/cnam/cnam2.0.6/cnam/bin/igpAgent ILLUMINET
<IGP Process>

cnam  7359  7343  1 19:33:08 pts/2    0:00 /ezConnect/
home/cnam/cnam2.0.6/cnam/bin/cnamgw 20 ILLUMINET
<cnamgw Process>

J - Start ezCallerID Web Browser [Standalone GUI]

If you are not using the TBS software from MetaSolv or another Operation Support System 
(OSS), then you must perform major steps J and K to send a test CNAM order (document) 
through the ezCallerID gateway application. 

For example, if your host machine name is larry, the HTTP Daemon Port Number (see "HTTP 
Daemon Port Number" on page 2-43) is 6601, and the ILEC you are working with is 
Bell Atlantic North (designated as BAN), your operations personnel would:

14. Type the URL http://larry:6601 in Netscape Communicator (4.61 or later) or 
Internet Explorer (4.15 or later) to find the ezCallerID application.

15. Click the HTML document file name - main.BAN.html to start the ezCallerID 
application.

Note: An alternative method to access the application is to specify the TCP address, the port number, 
and the HTML document in one command:
 http://IP_addr_of_CNAMGW_host:web_port_number/main.trading_partner_name.html
Example: http://38.254.200.10:6601/main.BAN.html
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K - Set-up a Service Center and DownStream Interface

Sign-on as the ezCallerID System Administrator

16. Follow the procedure in "Login to ezCallerID" on page 3-1 of the Defining Users and 
Privilege Levels chapter to establish yourself as the System Administrator of the 
ezCallerID application (with access to all operations)

Use one of the default  user IDs and passwords defined for the ezCallerID application.

Create Service Center

Create a Service Center (trading partner) to which  you will send CNAM orders (documents).

17. Follow the procedure in "Creating a New Service Center" on page 4-1 of the 
Communicating with Service Centers chapter.

Set-up Downstream Interface

To effectively test the ezCallerID application gateway to see if documents are transmitted and 
acknowledgements (or error messages, heaven forbid!) received, we need to set the gateway 
parameters.

18. Using the created Service Center number (The ezCallerID application uses only one 
service center. Its account number is 111111), follow the procedures in "Creating the 
DownStream Interface" on page 4-5 and "DownStream Frequency Details" on page 4-15.

19. For test purposes only, set the DownStream Frequency to be Periodic and set it for 180 
seconds.

User ID Password

s-adm00 SEC-ADM1

n-adm10 NET-ADM1
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L - Create CNAM Orders (documents)

You can create CNAM documents using the standalone DSET GUI or the MetaSolv TBS 
software.

20. Refer to Chapter 3 of the ezCallerID User’s Manual to create CNAM documents. 

M - Verify Orders Sent through Gateway

To verify the ezCallerID application worked correctly for your CNAM order, you need to 
examine two ezCallerID log files. Use Figure 2-2 as a guide to locating the correct directory 
where the log files are stored. You can refer to Chapter 5, Maintenance and Troubleshooting to 
see how to use the DSET stand-alone ezCallerID GUI to view the log files with a Web 
Browser.

Important!: Our strategy requires two steps: (1) Examine one log to verify that the CNAM document 
was successfully created and (2) view another log to ensure it went through the gateway 
successfully.

Assuming that we do not have a web browser available, we will access the log files directly 
using UNIX commands. 

21. Find the top-level log directory for this ILEC (trading partner).

cd $DP_DR/<Install_Dir>/cnam/www/cnam/log/<ILEC name>

22. Switch to the gateway log directory with the command:

cd CnamIgp

23. Select the Activity Log for the date you created the CNAM order.

An example log for documents (plus other application activity) August 10, 1999 
would be found in the file with the name: CNAMActivity.19990810
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24. Display the log file contents and look for this pattern to indicate order (document) 
information:

Figure 2-7: Portion of the Activity Log

25. Display the contents of the gateway trace log that corresponds to the document creation 
date. An example log for August 10, 1999 would be found in the file with the name: 
CNAMActivity.19990810.

cd Cnamgw

N - Backup Installation Directories

26. Once you have verified correct operation of the ezCallerID application, use these UNIX 
commands to create a backup of the DSET product installation on external media:

cd $DP_DIR
tar cvf /dev/rmt0 /cnam <--- use tape on /dev/rmt0

----- IGP agent: New Document Received ... Data = ----
IgpMessageData OCT_STR len=282
" MESSAGE  cNamCreate  { 
transid 3,
authkey "1111111111",
source "n-adm10",
dest "",
octnum "111111",
npa "972",
nxx "312",
line "1112",
recType "2",
recSType "00",
tType "I",
pIndicator "A",
cName "John Doe",
ocn "1111",
bsp "    ",
rao "222",
effdate "081199"
} ",
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O - Setup DSET Customer Service Dial-in Procedure

Set-up remote access for the cnam User ID that governs the ezCallerID application. DSET 
customer service personnel may need to dial-in and check the processes,view log files, and 
interpret key error messages to provide timely technical support.

Ensure that the cnam user ID has write access to the Product subdirectories (see Table 2-7) 
under the ezCallerID installation directory.

What to Do Next

After you start the ezCallerID, the Privilege Levels and User IDs need to be defined. Proceed 
to Chapter 3, Defining Users and Privilege Levels.

If the ezCallerID application does not successfully send a document through the gateway, 
begin using the problem determination procedures in Chapter 5, Maintenance and 
Troubleshooting.

Uninstalling the ezCallerID Application

You can uninstall ezCallerID by deleting all the files in the top-level cnam installation 
directory.

1. Change to the installation directory with the command: cd $DP_DP

2. rm -rf $DP_DIR

Example: rm -rf cnam2.0.6

CAUTION

This command removes all files and subdirectories without prompting the System 

Admninistrator. Use it when you are preparing to install an upgraded version of the 

ezCallerID application.
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Note: The rm command has no impact on the CNAM customer orders stored in the Oracle CNAM 
database or the User IDs and privilege levels stored in the Oracle CNSECDB datbase.
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Defining Users and Privilege Levels 3
This chapter provides instructions for setting up User IDs and defining application Privilege 
Levels.

Getting Started

The next pages show you how to login to the ezCallerID user-interface.

Login to ezCallerID

1. Start your Internet Browser and type the ezCallerID URL.

Note: Your system administrator will provide the full URL and directory pathname in the format:
http://_(host name)_:_(HTTP port number)_

The host name/IP address is the name or IP address of the machine on which the ezCallerID 
application is running.  The http port number is the port number the browser uses to access the 
software.

You may want to bookmark this URL in your Internet Browser so that you can quickly access 
the ezCallerID application.

My ezCallerID URL is: 

The Web Browser displays the Index Of directory links as shown in Figure 3-1.
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Figure 3-1: The Index of Directory in the Web Browser window

2. When the Browser displays the Index information, click the underlined text SWB.html.

The ezCallerID Clearinghouse window displays and the User Login dialog window 
displays as a temporary “pop-up” window. This is shown in Figure 3-2.

Click to login to 
ezCallerID.
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Figure 3-2: The ezCallerID window

Figure 3-3: User Login window

3. Type your User ID and password in the User Login window as shown in Figure 3-3.

These parameters are case sensitive. (Service Representatives get their initial password 
from the System Administrator. System Administrators, see the Default User IDs and 
Passwords section of the System Administration manual.)

4. Click OK. 

User Login window 
that pops-up.
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Figure 3-4 shows the Login Response window displaying a warning to unauthorized 
individuals.

Figure 3-4: Login Response window

5. Click OK.

The ezCallerID Console window displays in Figure 3-5. This is the primary window 
where you specify commands for the ezCallerID.

Figure 3-5: ezCallerID Console window
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 is 
Choosing Acceptable Passwords

The first time you login to the ezCallerID, you should change your password. You want to 
choose a password that you can easily remember and that other people have great difficulty 
guessing.

Rules for passwords

Your ezCallerID passwords must adhere to these rules:

• All passwords must begin with a letter (A-Z, a-z).

• All passwords are eight characters in length.

• Passwords are case-sensitive. Passwords kjones3* is not the same as Kjones3*.

• Passwords must contain at least one number (0-9).

• Passwords must contain one special character (!, @, #, $, %, -, &, *, >, or a space.)

An example of an acceptable password is kjones3*.

The passwords kjones22, kjones*@, and kjones are unacceptable.

Note: If you receive the error message shown in Figure 3-6, the User ID you attempted to use,
already in use by another Service Representative.

Figure 3-6: User ID Login Error Message
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Modifying Passwords

To change your Password:

1. Select the Admin > User Menu > Modify Password command on the cascading menus.

The User Password Modify window displays as in Figure 3-7.

Figure 3-7: User Password Modify window

2. Type the User ID.

3. Type the current password in the Old Password field.

4. Type the new password in the New Password field. See "Choosing Acceptable 
Passwords" on page 3-5 for password requirements.

5. Click OK.

A confirmation window displays indicating a successful password change.

6. Click OK to close the window.
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Exiting the ezCallerID

1. Select Session > Exit.

The Logout confirmation window displays as in Figure 3-8.

Figure 3-8: Logout Window

2. Click Yes to close the ezCallerID Console primary window.
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is 
Organization of Menu Commands

Most ezCallerID commands are accessed using the menu bar and its subordinate menu 
commands.

Figure 3-9: ezCallerID Menu Commands

Some commands are reserved for the System Administrator and other specific users. All 
commands under the Admin menu are reserved for some of these User IDs.

Note: If a menu command is “grayed-out”, your User ID does not have privileges to perform th
command. If your User ID needs to perform a function, contact your ezCallerID System 
Administrator and inform the individual that the Privilege Level assigned to your User ID 
incorrect.
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r ID 
 

The Service Center

A Service Center is the communication link between you and the Line Information Database 
(LIDB). It is needed to port (exchange) telephone number information. It works similar to an 
electronic mail box. You use DSET’s ezCallerID to request changes to a customer’s calle
information and the request is manually sent (via email) to a Service Center. The Service
Center is a hub for the clearinghouse to confirm data with the LIDB and transfer the 
information back to the CLEC.

Only the System Administrator can create a Service Center; however, you can display 
information about it.

For assistance with logging into ezCallerID, see "Login to ezCallerID" on page 3-1.

Viewing the List of Service Centers

You can display a list of all Service Centers. This information cannot be changed.

1. Select Service Centers > View all Service Centers.

A list of all Service Centers display as shown in Figure 3-10.

Figure 3-10: Service Centers Window

2. Double-click the text of the Service Center.

The Service Centers window displays, as shown in Figure 3-11.
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Figure 3-11: Service Center Info window

The Service Center number and its description display. This information is view-only.

3. Click OK to close the windows.
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Viewing the Data Transfer Schedule

As a user who creates, deletes, and modifies customer LIDB records, you do not control the 
portion of the software that decides when to transmit customer records to the Service Centers 
and when the ezCallerID receives notification or error messages in return.

Consult your ezCallerID System Administrators regarding the days and times that ezCallerID 
information is transferred between your computer and the Service Centers. Only these 
individuals can actually change the data transfer schedules.

You have the ability (privileges permitting) to see how often the DownStream Interface (DSI) 
transfers data.

1. Select DownStream Interface > View DSI Info.

The Get DSI Info window displays as shown in Figure 3-12.

Figure 3-12: Get DSI Info window

2. Select the appropriate Service Center from the drop-down selection list in the Service 
Center field.

3. Click OK.

Figure 3-13 illustrates the resulting DSI Info window that displays.
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rders 
Figure 3-13: DSI Info window
See UNRESOLVED XREF for field descriptions.

4. Click OK.

If you want to view the data transfer times, you will examine the details of the 
DownStream Frequency information

DownStream Frequency Details

You can view the DownStream frequency for when the system checks for new ezCallerID 
documents.

It can be set to:

• Specific times on selected days of the week

• A constant time interval between data transfers.

WeekMask

This data transfer schedule specifies the actual times (starting and stopping) when the 
ezCallerID performs the operations. Each day has its own schedule.

1. Hold down the <Shift> key and click the weekMask field to select it.

2. To view the Frequency schedules that control when the transmission of ezCallerID o
happen, double-click the WeekMask Frequency text with the white background.

ezCallerID data 
transmission at 
regular intervals.

ezCallerID data 
transmission at 
assigned times 
during the week
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The WeekMask window displays, as shown in Figure 3-14.

Note: Only the System Administrator can change the DownStream Frequency information.

Figure 3-14: Week Mask window
See UNRESOLVED XREF for field descriptions.

3. Select the text line under the day of the week by clicking.

4. Double-click on a text line to view the start and stop transmission/reception times.

The Intervals of Day window displays in Figure 3-15.

Selected start 
and stop times 
of the data 
transfer.
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Figure 3-15: Interval of Day window
See UNRESOLVED XREF for field descriptions.

c. Click OK to close the Interval of Day window.

Periodic

This option controls the transfer of ezCallerID documents by time interval.

1. Hold down the <Shift> key and click the periodic line to select it.

2. If you double-clicked the Periodic Frequency, (see Figure 3-13) the Interval window 
displays, as shown in Figure 3-16.

Figure 3-16: Interval window

These Frequency settings tell the ezCallerID to transfer data every n seconds.

3. Click OK to exit the windows.
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ALL BELOW HERE IS SYSTEM ADMIN PRIVILEGES INFORMATION FROM THE 
CHAPTER

Default System Administrator User ID and Passwords

When you installed ezCallerID, two User IDs and passwords with System Administrator 
Privilege Level zero were defined, All USer IDs and Passwords are case sensitive, For mor 
information on Passwords, see "Choosing Acceptable Passwords" on page 3-5.

Navigation

This illustration may assist you with finding your way around tin the ezCallerID.

Table 3-1: Default User IDs and Passwords

User ID Password

s-adm00 SEC-ADM1

n-adm10 NET-ADM1
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Figure 3-17: Navigation for ezCallerID
3-16 1091-B DRAFT November 15, 1999



ezCallerID System Administration Manual Defining Users and Privilege Levels
Privilege Levels

Users are entered into the system based on the privilege level determined by the administrator.  
The administrator determines which functionality is enabled for each privilege level.  For 
example, privilege level 1 may have view-only permission for the entire system.  Users at this 
level are unable to enter any data or save any material.  Similarly, a user with privilege level 6 
may have edit and save permissions for any files in the system. 

Operation Codes

The administrator creates privilege levels based on the Operations Codes.  Each menu option 
in the GUI is assigned an Operation Code as shown in the Privilege Operation Codes Table. 
The administrator can assign as many Operations Codes to a privilege level as necessary. 

When users login to the ezCallerID, they are only able to perform those functionalities that are 
listed in their privilege level.  Any GUI operation not included in their privilege level is 
disabled and the menu option is inaccessible.

Table 3-2 lists the Operation Codes and their associated menu ocomman.

Table 3-2: Privilege Operation Codes (1 of 2)

Code Operation Description

-1 All

100 Privilege Level Create

101 Privilege Level Modify

102 Privilege Level View

103 Privilege Level Delete

104 User Create

106 Modify User Privilege Level

107 User View

108 User Delete
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Factors to Consider

Since you are determining each person’s authority in the ezCallerID, consider what each
person does in their daily job. Do you want a Service Rep. changing upload schedules w
could effect the entire system’s processing?

Also, decide who will be correcting ezCallerID document errors and who will be checking
confirmation messages. Is it your job or the Service Reps. job to check the Logs and be th
line of defense for errors that show there?

Privilege Level Sample

Here is a sample of Privilege Level and Operations Code settings that you may find usef

112 Account Info View

113 Account Create

114 DSI Info

115 DSI Create

116 DSI Info Modify

117 Activity Log

120 ezCallerID Create

121 Get ezCallerID Documents Data

Table 3-3: Privilege Level Sample (1 of 2)

Operation 
Code

User Type/Title Privilege Operations

0
System 
Administrator

 All operations are selected. This is done automatically during 
installation

1
System 
Administrator 
Assistant

Select all operations.

Table 3-2: Privilege Operation Codes (2 of 2)

Code Operation Description
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Creating Privilege Levels

The administrator can create new privilege levels by assigning specific operations to each 
privilege level.

1. Select Admin > Privilege > Create.

The Privilege Level window displays as shown in Figure 3-18.

Figure 3-18: Privilege Level Create window
See for field descriptions.

2 Manager
Select most of the operations. Do not select: DSI Info Create, DSI 
Info Modify, and Account Create

3 Supervisor
Select: View Confirmation Data, View Outstanding Error Data, 
View Account Info, DSI Info View, Request Activity Log, Create 
E911, View SOI Documents Data

4 Senior Service Reps
Select: View Confirmation Data, View Outstanding Error Data, 
View Account Info, DSI Info View, Request Activity Log, Create 
E911, View SOI Documents Data

5 Service Reps.
Select: View Confirmation Data, View Outstanding Error Data, 
View Account Info, View SOI Documents Data

Table 3-3: Privilege Level Sample (2 of 2)

Operation 
Code

User Type/Title Privilege Operations

Use the scroll bar to 
view all the 
Operation Codes.
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.

2. Type the Privilege Level number. (zero is already done for you)

3. Type a brief description of the privilege level in the Privilege Type field. This field 
accepts up to 100 alphanumeric characters.

4. Select each operation from the list.

5.  Click OK.

The Operation Response window displays, indicating that the operation was successful.

6. Click OK.

Repeat these steps for each Privilege Level.

What to Do Next

Once all the Privilege Levels are determined, you associate Privilege Levels to User IDs. See 
Creating a User ID and Assigning a Privilege Level on page 3-24.

Modifying the Operations Code of a Privilege Level

1. Select Admin > Privilege > Modify.

The Privilege Level Modify window appears as shown in Figure 3-19.

CAUTION

Users with Privilege Level 0 (or a Privilege Level that permits deleting or modifying other 
ezCallerID users’ profiles) can delete or change the ezCallerID Administrator’s profile.

Users with a Privilege Level 0 (or a Privilege Level that permits them to delete or modify
Privelege Levels) can delete or change all the privilege levels,including Privilege Level 0
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Figure 3-19: Privilege Level Modify window
See for field descriptions.

2. Enter the Privilege Level and description.

Note: The operations added to the existing Privilege Level will not display, you must recreate the 
level.

3. Choose each operation.

4. Click OK. 

The Operation Response window appears, indicating that the operation was successful.

5. Click OK.

Viewing All Privilege Levels and Details

This function allows the administrator to view the Operations Codes associated with each 
Privilege Level.

1. Select Admin > Privilege > View.

The Privilege Level View window displays with a list of all privilege levels.
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Figure 3-20: Privilege Level View window

2. Double-click the privilege level.

The Privilege Level View Response window appears aas shown in Figure 3-21.

Figure 3-21: Privilege Level View Response window
See for field definitions.

The Privilege Level Details window is read-only, you cannot edit the fields. See Table 
3-2 on page 3-17 for a description of Operation Codes.

3. Click OK to close the windows.
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Deleting Privilege Levels

The administrator can also delete privilege levels that are no longer needed.

1. Select Admin > Privilege > Delete.

The Privilege Level Delete window displays.

Figure 3-22: Privilege Level Delete window

2. Type the Privilege Level being deleted.

3. Click OK. 

The Operation Response dialog box displays, indicating that the operation was 
successful.

Figure 3-23: Operation Response window

4. Click OK.

5. Click OK to close the window.
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Creating a User ID and Assigning a Privilege Level

Now that the Privilege Levels are established, you can create a User ID and associated it to a 
Privilege Level.

1. Select Admin > User Menu > Create New User.

The User Create window displays.

Figure 3-24: User Create window

2. Type the User ID.

3. Type the privilege level for this user in the Privilege Level field.

4. Click OK.  

The Operation Response window displays, indicating that the operation was successful.

5. Click OK to close the window.

Changing Passwords

When the System Administrator creates a User ID and assigns a Privilege Level, the User ID 
password defaults to LNP-SMS1. Only the System Administrator should use this password, 
assign a different password immediately and ask the User to change it to a private password..
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Password Requirements

All passwords must begin with a letter and be eight characters. Passwords must also contain 
one number and one special character. Available special characters are !, @, #, $, %, -, &, *,> 
and a space. 

For Example: kjones3*

Follow these procedures to change a Password:

1. Click Admin > User Menu > Modify Password.

The User Password Modify window displays.

2. Type the User ID.

3. Enter the current password in the Session Password field.

4. Enter the new password in the New Password field. See above for password 
requirements.

5. Click OK.

A window displays indicating a successful change.

6. Click OK to close the window.

User Forgets A Password

When Service Representatives forget passwords, you cannot use the ezCallerID to look up the 
password corresponding to the User ID.. Instead, you modify the password by deleting the 
User ID’s account and recreating the User ID with the default password.  Then the user c
in and modify the password according to suggestions. (See "Choosing Acceptable Passw
on page 3-5.)

Modifying the Privilege Level Assigned to a User ID

The Administrator can modify the privilege level of a user.

1. Select Admin > User Menu > Modify.

The User Modify window appears.
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Figure 3-25: User Modify window

2. Type the User ID.

3. Type the new privilege level.

4. Click OK. 

The Operation Response window appears, indicating that the operation was successful.

5.  Click OK to close the window.

Viewing All User IDs and their Privilege Levels

The Administrator can view a list of all users who are established within ezCallerID.

1. Select Admin > User Menu > View.

The User View window appears.

Figure 3-26: User View window

2. Click OK.
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The User View Response window provides a list of all User IDs, as shown in 
Figure 3-27.

Figure 3-27: User View Response window

3. To view more User ID details, select and double-click a User ID. 

The User View Response window appears.

4. Click OK to close the window.

Deleting a User ID

The System Administrator privilege can delete a user from the application.  Once a user ID is 
deleted, it must be re-created before that user can access the application again.

1. Select Admin > User Menu > Delete.

The User Delete window appears.

Figure 3-28: User Delete window

2. Type the User ID.

3. Click OK twice.
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Communicating with Service Centers 4
This chapter describes how to create Service Centers and configure the communication link 
between you and the UNIX File System (UFS).

Creating a New Service Center

Note: When you create a new Service Center, the corresponding DownStream Interface (DSI) 
information must also be created before it will work.

1. Select Service Centers > Create a New Service Center.

The Create Service Center window displays, as shown in Figure 4-1.

Figure 4-1: Create Service Center window

2. Type the Service Center abbreviation in the Service Center field. This can be up to 6 
digits.

3. Type the full name of the Service Center in the Description field. This can be up to 100 
alphanumeric characters.

4. Click OK. 

The Operation Response window displays, indicating your change was successful.

5. Click OK to close the window.
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6. Next, you must create the DownStream Interface (DSI), skip to ***
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Viewing All Service Centers

1. Select Service Centers > View all Service Centers.

The Get Service Centers window appears.

2. Click OK.

The Service Centers window displays a list of all Service Centers, as shown in 
Figure 4-2.

Figure 4-2: Service Centers window with a list of all Service Centers.

3. Double-click a Service Center for more detail.

The Service Center Info window displays.

Figure 4-3: Service Center Info window 

4. Click OK to close the windows.
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Deleting a Service Center

Once a Service Center is created, it cannot be deleted.
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DownStream Interface (DSI)

The DownStream Interface (DSI) is used to transfer the ezCallerID documents to the Service 
Center for processing.  DSI information must be established for each Service Center.

Scheduling Sending and Receiving Data

When you set up the DSI, you are defining how often you want the ezCallerID to retrieve 
information from the Service Center and how often you want the ezCallerID to send 
information to the Service Center. There are two ways you can set up receiving and sending 
data:

• Indicate a set time for uploads or downloads to occur each day. This is called a Week
Schedule.

• Indicate when uploads and downloads should occur throughout the day at timed inter
This is called a Periodic Schedule.

UpStream Frequency refers to the upload of data from the Service Center to the ezCalle

DownStream Frequency refers to the download of data from the ezCallerID to the Servic
Center.

Factors to Consider

Downloading and uploading information causes traffic on your network. To minimize traff
and enhance performance, you should download and upload information only when nec

For instance, if your service representatives cannot process more than four ezCallerID re
in an hour, you should not have a periodic download set up to occur every 15 minutes. A
the Service Center only sends ezCallerID responses at 8:00 a.m. and 2:00 p.m., you sho
set a daily upload to occur at 7:00 a.m. and 1:00 p.m.

Creating the DownStream Interface

Creating the DownStream Interface involves entering many pieces of information.
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s in 
• DownStream Frequency - Start and Stop by Days or by Periods

• Up Stream Frequency - Start and Stop by Days or by Periods

We created a procedure for each piece of information you need. Follow these procedure
sequence.

1. Opening the Create DSI Information Window

2. Entering UpStream Frequency

3. Entering DownStream Fequency

Once you enter all the information on the Create DSI box, you will click OK and create the 
DSI.

Note: You must create the Service Center before you can create DSI information.

Opening the Create DSI Information Window

1. Select DownStream Interface > Create DSI.

The Create DSI window appears, as shown in Figure 4-4.

Figure 4-4: Create DSI window
See for field descriptions.

2. Select the Service Center from the pull-down menu in the Service Center field.

Use the drop-down 
selection list to 
choose the Service 
Center.
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3. Next, you schedule the DownStream and UpStream transmission frequency. You can 
choose to trasnmit by Day or by Time. This determines how often information is 
transferred to and from the Service Center.

Entering DownStream Fequency

This determines how often documents are sent to the Service Center.

Note: You can schedule the DownStream to occur daily or by a time period, Not Both. Decide which 
method to use, then see below for directions.

For Daily Schedule:

1. From the Create DSI window, (see Figure 4-4) double-click the white space next to 
WeekMask in the DownStream Frequency field. If there is no white space, hold the Shift 
key and click the WeekMask line. This makes the WeekMask active, now you can 
double-click the white space.

The Week Mask window displays, as shown in Figure 4-5.
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Figure 4-5: Week Mask window
See for field descriptions.

2. Click the Add bar for each day of the week to transmit.

3. Your window will look like this:
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Figure 4-6: Daily Schedule window with days selected

4. Click the text below the Add bar.

The Intervals of Day window displays, as shown in Figure 4-7.

Figure 4-7: Intvls of Day Window

5. Type the start and stop times for transmissions that day. Use military time.

6. Click OK to close the windows and accept the schedule.

The WeekMask window re-displays.

7. Repeat Step 4 on page 4-4 through Step 6 on page 4-6 for each day of the week you 
selected.

8. When you are finished, the WeekMask window will look similar to Figure 4-8.

Figure 4-8: Complete WeekMask window

You can type the 
times or select from 
the drop-down 
selection list.
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To Delete a Time:

1. Hold the Control key and right-click the text.

The time is removed.

For Periodic Schedule

1. From the Create DSI window, (see Figure 4-4) click the ABSENT text next to the 
DownLoad Frequency field.

The Periodic Frequency becomes active.

2. Click the white space next to Periodic.

The Interval window displays, as shown in Figure 4-9.

Figure 4-9: Interval window

3. Type how often you want the transmission to occur. If you choose this method, we 
recommend 3,600 seconds.

4. Click OK to accept the schedule.

5. Next, you enter the UpStream Frequency. Your options are the same as the DownLoad 
Frequency. This determines how often information is returned from the Service Center.

Entering UpStream Frequency

This determines how often information is returned from the Service Center.

Note: You can schedule the UpStream to occur dialy or by a time period, Not Both. Decied which 
method to use, then see below for directions.
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For Daily Schedule:

The options are the same for UpStream as for DownStream. Follow *** through *** in the 
***to enter the daily UpStream Schedule.

For Periodic Schedule:

The options are the same for UpStream as for DownStream. Follow ***through*** in the 
***to enter the daily UpStream Schedule.

6. Click OK when you complete all the schedule for the transmissions.

The DSI information is created an you can now communicate with the Service Center!

Modifying the DownStream Interface

1. Select DownStream Interface > Modify DSI.

The Modify DSI Info window displays.

2. Select the appropriate Service Center from the pull-down menu.

3. Click OK.

The Modify DSI Info window displays, as shown in Figure 4-10.

Figure 4-10: Modify DSI Info window
See for field descriptions.

4. Modify the information using the same method as you created it. See "Creating the 
DownStream Interface" on page 4-5.

5. Click OK when finished.
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END OF EXISTING MATERIAL IN SYSTEM ADMIN GUIDE -

STUFF FROM USER MANUAL ----------------------------------------------------------------------

A Service Center is the communication link between you and the Line Information Database 
(LIDB). It is needed to port (exchange) telephone number information. It works similar to an 
electronic mail box. You use DSET’s ezCallerID to request changes to a customer’s calle
information and the request is manually sent (via email) to a Service Center. The Service
Center is a hub for the clearinghouse to confirm data with the LIDB and transfer the 
information back to the CLEC.

Only the System Administrator can create a Service Center; however, you can display 
information about it.

For assistance with logging into ezCallerID, see "Login to ezCallerID" on page 3-1.
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Viewing the List of Service Centers

You can display a list of all Service Centers. This information cannot be changed.

1. Select Service Centers > View all Service Centers.

A list of all Service Centers display as shown in Figure 4-11.

Figure 4-11: Service Centers Window

2. Double-click the text of the Service Center.

The Service Centers window displays, as shown in Figure 4-12.

Figure 4-12: Service Center Info window

The Service Center number and its description display. This information is view-only.

3. Click OK to close the windows.

Creating and Modifying a Service Center

Only the System Administrator privilege level can create a Service Center. Once it is created, it 
cannot be deleted. See the ezCallerID System Administration Manual.
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Viewing the Data Transfer Schedule

As a user who creates, deletes, and modifies customer LIDB records, you do not control the 
portion of the software that decides when to transmit customer records to the Service Centers 
and when the ezCallerID receives notification or error messages in return.

Consult your ezCallerID System Administrators regarding the days and times that ezCallerID 
information is transferred between your computer and the Service Centers. Only these 
individuals can actually change the data transfer schedules.

You have the ability (privileges permitting) to see how often the DownStream Interface (DSI) 
transfers data.

1. Select DownStream Interface > View DSI Info.

The Get DSI Info window displays as shown in Figure 4-13.

Figure 4-13: Get DSI Info window

2. Select the appropriate Service Center from the drop-down selection list in the Service 
Center field.

3. Click OK.

Figure 4-14 illustrates the resulting DSI Info window that displays.
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Figure 4-14: DSI Info window
See UNRESOLVED XREF for field descriptions.

4. Click OK.

If you want to view the data transfer times, you will examine the details of the 
DownStream Frequency information

DownStream Frequency Details

You can view the DownStream frequency for when the system checks for new ezCallerID 
documents.

It can be set to:

• Specific times on selected days of the week

• A constant time interval between data transfers.

WeekMask

This data transfer schedule specifies the actual times (starting and stopping) when the 
ezCallerID performs the operations. Each day has its own schedule.

1. Hold down the <Shift> key and click the weekMask field to select it.

2. To view the Frequency schedules that control when the transmission of ezCallerID o
happen, double-click the WeekMask Frequency text with the white background.

ezCallerID data 
transmission at 
regular intervals.

ezCallerID data 
transmission at 
assigned times 
during the week
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The WeekMask window displays, as shown in Figure 4-15.

Note: Only the System Administrator can change the DownStream Frequency information.

Figure 4-15: Week Mask window
See UNRESOLVED XREF for field descriptions.

3. Select the text line under the day of the week by clicking.

4. Double-click on a text line to view the start and stop transmission/reception times.

The Intervals of Day window displays in Figure 4-16.

Selected start 
and stop times 
of the data 
transfer.
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Figure 4-16: Interval of Day window
See UNRESOLVED XREF for field descriptions.

d. Click OK to close the Interval of Day window.

Periodic

This option controls the transfer of ezCallerID documents by time interval.

1. Hold down the <Shift> key and click the periodic line to select it.

2. If you double-clicked the Periodic Frequency, (see Figure 4-14) the Interval window 
displays, as shown in Figure 4-17.

Figure 4-17: Interval window

These Frequency settings tell the ezCallerID to transfer data every n seconds.

3. Click OK to exit the windows.
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This chapter provides recommendations for monitoring, identifying proflems with, and 
backing-up the ezCallerID application to ensure optimum performance.The chapter is divided 
into four parts:

• Preventative monitoring activities to ensure proper ezCallerID operation

• Troubleshoot problems that can arise ...............................................................  on pag

• Possible corrective actions you would take to address the problems ...............  on pag

• Backing-up and archiving ezCallerID application data....................................  on page

• Oracle Database Maintenance ..........................................................................  on pag

Important!: Throughout this chapter, the ezCallerID Oracle database instances are referred to a
CNAM for the ezCallerID orders (documents) database and CNSECDB for the Security 
Agent database.

Preventative Monitoring

As the System Administrator, we recommend you monitor the ezCallerID application and
third-party software activity on your UNIX system in these areas:

• Checking Disk space...........................................................................................  on pa

• Application Process health .................................................................................  on pa

• Viewing ezCallerID logs (Application operation)..............................................  on page

Checking Disk Space

As the ezCallerID System Administrator, you can monitor the ezCallerID Gateway on a 
regular basis. You have three areas where you will be storing ezCallerID information on 
UNIX machine:
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• The DSET ezCallerID application files

• CNAM orders (in an Oracle tablespace)

• Notification and error messages

The ezCallerID Installation

Use the UNIX commands on the ezCallerID file directory to monitor disk space:

• df (number of free disk blocks)

• du (number of disk blocks in use) 

Check the amount of disk space in use for your entire ezCallerID installation and determin
number of free kilobytes, allocated kilobytes, and disk usage for the installation.

1. cd $DP_DIR/cnam

2. df -bt
du -s

CNAM Orders (Documents)

For the instance of the Oracle database you created for the ezCallerID application orders
the file directory:

$ORACLE_MOUNT/oracle1/oradata/CNAM/data01.dbf

This database increases in size by 5 Mb increments until it reaches a maximum size of 15
Use the df and du commands to monitor disk space for the file directory defined by the 
$ORACLE_MOUNT environment variable.

Notification Messages and Errors

Your message queue usage increases as notifications and errors are uploaded from your
partner. You need to check your disk usage on a regular basis depending upon the frequ
you schedule notification uploads. 

The notification messages reside in the file directory:

$DP_DIR/cnam/DATA/ACNTS/<Trading Partner>/input
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Application Process Health

Application Gateway Status

As System Administrator, you need to check the status of the ezCallerID application. You can 
do this from any UNIX machine.

1. On any UNIX terminal, at the command prompt, enter command:

ps -aef | grep startup

The system reply will be similar to:

cnamadm 14951  1 0 19:51:04 pts/8  0:00 startup/export/home/
cnamadm/cnamGW/cnam/config/cnam.startup

(CNAMadm is an example of a User ID, and 14951 is a sample process ID)

All ezCallerID Processes

2. To check on the other ezCallerID processes, simply substitute the other process names in 
place of the process name startup:

ps -aef | grep cnamgw
ps -aef | grep secAgent
ps -aef | grep cnamigp
ps -aef | grep thttp
ps -aef | grep namemgr

These five processes should always be running and the results should always resemble 
the system response in step one.

CORBA (Orbix) Software

1. Verify the CORBA software (Orbix) process daemon is running by using the UNIX 
command:

ps -ef|grep orbixd

You should see a response similar to this next line where cnam is the user ID, 4893 is 
the process ID that identifies Orbix daemon, and 16:55:56 is the current time.
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root   307     1  0   Oct 26 ?        0:12 /opt/iona/
OrbixMT_2.3c/bin/orbixd
cnam  4893  4877  0 16:55:56 pts/11   0:00 grep orbix

Oracle Software and Database Instances

The UNIX script exerpt shown after this paragraph can be used to determine if any  instance of 
an Oracle database is properly mounted and ready.

process=‘ps -ef|grep <Oracle DB Name>|wc -l‘
if [ $process -lt 6 ] ; then
  echo "Warning: Your system has not started the database"
  echo "$CNAM, remember to start up the database and"
  echo "register the schema manually."
  echo 
else

1. Test that the Oracle ezCallerID databases are online by typing the commands:

ps -ef|grep ora|grep CNAM     or
ps -ef|grep ora|grep CNSECDB  

You should see a response similar to the following lines for the two Oracle databases 
CNAM and CNSECDB:

Figure 5-1: Example Console Output for Oracle Databases

oracle  4843  1  0 16:45:13 ?  3:06 oracleCNAM (LOCAL=NO)
oracle  1078  1  0 Oct 26 ?    0:11 ora_dbw0_CNAM
oracle  1076  1  0 Oct 26 ?    0:04 ora_pmon_CNAM
oracle  1080  1  0   Oct 26 ?  0:12 ora_lgwr_CNAM
oracle  1082  1  0   Oct 26 ?  2:40 ora_ckpt_CNAM
oracle  1084  1  0   Oct 26 ?  0:13 ora_smon_CNAM
oracle  1086  1  0   Oct 26 ?  0:02 ora_reco_CNAM

oracle  1095  1  0   Oct 26 ?  0:04 ora_pmon_CNSECDB
oracle  1097  1  0   Oct 26 ?  0:00 ora_dbw0_CNSECDB
oracle  1099  1  0   Oct 26 ?  0:02 ora_lgwr_CNSECDB
oracle  1101  1  0   Oct 26 ?  2:25 ora_ckpt_CNSECDB
oracle  1104  1  0   Oct 26 ?  0:14 ora_smon_CNSECDB
oracle  1106  1  0   Oct 26 ?  0:02 ora_reco_CNSECDB
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Viewing ezCallerID Logs (Application Operation)

To track a CNAM order, the System Administrator (and key operations personnel) use DS
extensive event logging facility to monitor  each step of the order transmission.

You can view log files to determine how an ezCallerID request is progressing. Also, if 
something goes wrong and an ezCallerID request is not processed, you can determine w
the problem occurred by displaying the log files.

 To view the log files from any web browser, the files should be located in a directory tha
accessible to the web server.

Log Directory Structure

All processes in the ezCallerID read a configuration file to determine the UNIX directory 
where log files are created for each trading partner. At installation, you created a director
structure where the Log Root is a subdirectory of the Web Server Root directory similar t

• Web Server Root Directory

– CNAM Log Root Directory

Once you understand the UNIX file structure for the DSET logs, a System Administrator 
use either UNIX commands or the Web Browser in the ezCallerID application to view log

The ezCallerID logs reside in the UNIX directories (see Figure 5-2):

• $DP_DIR/cnam/www/cnam/log/< trading partner>/CnamIgp

• $DP_DIR/cnam/www/cnam/log/< trading partner>/Canmgw

• $DP_DIR/cnam/www/cnam/log/< trading partner>/Security

The <trading partner> is usually expressed as a three or four letter ILEC designation 
such as PAC (Pacific Bell), SWB (Southwestern Bell), USW (US West), etc.

CAUTION

The log directory must be a subdirectory of the Web Server root  directory, so it is accessible 
to the web server and the user’s web browser.
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(See Table 5-2 for a description of the contents of different log files.)

Figure 5-2: Log Directory Structure

Web Server Root Directory

CNAM Log Root Directory

cnamgw cnamIgp Security

Trading
Partner 2

Trading
Partner 3

Trading
Partner 1

. . . . . .
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Figure 5-3: Index of web server root directory window

Figure 5-3 shows the top-level directory of the web server. It contains the root directory for all 
the ezCallerID logs and Java/HTML software for a specific trading partner. In this example, 
the trading partner is Southwestern Bell, denoted by SWB.

Finding Specific ezCallerID Logs

While it is possible to UNIX commands to navigate through the ezCallerID log subdirectories 
and view individual files, the DSET standalone GUI permits you to view the file directory 
structure and the contents of any log file easily. 

1. Login to the ezCallerID application (see "Login to ezCallerID" on page 3-1.)

2. Select the Log > View command on the ezCallerID primary console window. 

A web browser displays with the Index of the /Log file directory, as shown in 
Figure 5-4.

Root Log Directory
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Figure 5-4: Index of /log directory window

This is a list of the log directories available to this ezCallerID application. Each directory 
provides specific information to the System Administrator.

Table 5-1: Log Directories

Directory Name Description

Cnamgw

Contains daily logs that show the order (document) activity through the ezCallerID 
gateway. The trace logs highlight significant software events from a developer’s 
perspective. This information is usefully to DSET customer service personnel to help 
determine solutions to problems.

CnamIgp
Contains daily logs that define the activity of documents sent to the trading partner and 
any notification messages/errors received from the trading partner (ILEC).

Security
This file describes all the security activity (establish User IDs, establish Privilege levels, 
change User ID privileges, assign or change  functionality of privilege levels.)

For this example, we 
selected the CnamIgp log 
directory.
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3. Click the directory to display a list of log files contained in the directory.

The browser now displays all the log file names from the selected directory.

Figure 5-5: Index Of /log/Cnamgw directory window
November 15, 1999 1091-B DRAFT 5-9



Maintenance and Troubleshooting ezCallerID System Administration Manual

t, 

in 
Type of Logs

The ezCallerID performs five types of activity, software event monitoring, and security 
logging.  The different types of logs generated include:

4. Click the specific log file you want to view. From a System Administrator’s viewpoin
most of the useful information is contained in the CnamgwActivity.YYYYMMDD 
and CnamIgpActivityYYYYMMDD types of logs.

Exerpts from the contents of several Activity log file displays. An example is shown 
Figure 5-6.

5. Select the View > Refresh command to update the display of the log contents.

6. To stop displaying the log file contents, exit the Web browser window.

The ezCallerID main console window displays.

Table 5-2: Types of Logs

File Name Description

CnamIgpActivity.YYYYMMDD

Contains logs that show when the IGP receives orders from the 
gateway or messages/errors from the trading partner.
YYYY is a 4-digit year
MM is a 2-digit month
DD is a 2-digit day

CnamIgpTrace.YYYYMMDD
Logs generated primarily for troubleshooting of the ezCallerID Igp 
module.  It has printed statements at different software checkpoints, 
that is, operation entry, operation exit, and error conditions.

SecurityTrace.YYYYMMDD
This file contains security changes made to user ID validation files on 
the indicated date.

CnamgwActivity.YYYYMMDD
Contains all user ID logins and logouts as well as ezCallerID’s key 
functions of handling CNAM orders. Also reflects the ezCallerID orders 
passed from the CORBA/OSS software.

CnamgwTrace.YYYYMMDD
This file contains error reports or other unusual activities happening in 
the ezCallerID Gateway. This log primarily is for troubleshooting. It has 
trace statements at different software checkpoints.

DROP
(only for CORBA interface)

Directory where CNAM documents reside when the link between the 
CNAM Gateway and the OSS server is interrupted while transferring a 
document.
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Figure 5-6: Activity Log for ezCallerID Gateway

Figure 5-6 illustrates some of the information contained in the 
CnamgwActivity.YYYYMMDD logs. 

CNAM-GW >> ACTIVITY LOG << 1999 Nov 12 15:17:18 >>  
No user login : Message type - FROM OSS 
MESSAGE IgpLoginRequest {transid 1, authkey "0000000000", source "s-adm00", dest "", 
userid "s-adm00", passwd "SEC-ADM1", spid ""} 

 CNAM-GW >> ACTIVITY LOG << 1999 Nov 12 15:17:29 >>  
 User - s-adm00 : Message type - FROM OSS 
MESSAGE CreateAccount {transid 2, authkey "1111111111", source "s-adm00", dest "", 
acntName "11111", aText "test"} 

 CNAM-GW >> ACTIVITY LOG << 1999 Nov 12 15:17:46 >>  
 User - s-adm00 : Message type - FROM OSS 
MESSAGE CreateDsi {transid 4, authkey "1111111111", source "s-adm00", dest "", acntName 
"11111", protocol ABSENT, inQ {weekMask ABSENT, periodic ABSENT}, outQ {weekMask 
ABSENT, periodic {interval 30}}} 

 CNAM-GW >> ACTIVITY LOG << 1999 Nov 12 15:18:22 >>  
 User - s-adm00 : Message type - FROM OSS 
MESSAGE lIDBCreate {transid 5, authkey "1111111111", source "s-adm00", dest "", octnum 
"111111", npa "111", nxx "111", line "1111", recType "0", recSType "P", recSType2 "0", pkey "0", 
acode "C", pin "", pinaction "I", cardtype "U", brindicator "B", cardnum "", sind "H", lscnbind "Y", 
billname "", holdername "", usagecat "055", addrline "", addrline2 "", addrcity "", addrstate "", 
addrzip "", ocn "", bsp "", rao "", bnscode "A", effdate "", clcode ""} 
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Figure 5-7: Activity Log for the Interconnectivity Gateway Platform

Figure 5-7 illustrates some of the CNAM order information contained in the 
CnamIgpActivity.YYYYMMDD logs. 

Tracking a Request

Needs Information From Quality Assurance And Customer Service To Formulate 
Procedures For This Section.

  >> ACTIVITY LOG << 1999 Nov 12 16:37:58 >>  
 ----- IGP agent: New Document Received ... Data = ----
IgpMessageData OCT_STR len=280  
" MESSAGE  cNamCreate  { 
 transid 0,
 authkey "1111111111",
 source "", 
 dest "",
 octnum "111111",
 npa "444",
 nxx "444",
 line "4444",
 recType "2",
 recSType "00",
 tType "C",
 pIndicator "R",
 cName  "90123451",
 ocn  "1111",
 bsp  "1111",
 rao  "111",
 effdate  "110399"
 }"
----- End of Document -----
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Troubleshooting Problems

Using a set of test procedures and available programs, you can determine the probable source 
of the difficulty with the ezCallerID application. Use Table 5-3 to isolate the source of the 
ezCallerID application difficulty and then perform the appropriate action in the following 
section of this chapter to correct the problem. When problems arise with the ezCallerID 
application, always restart the CNAM Gateway. This helps determine if the problem is with the 
ezCallerID product, or with one of the third-party applications with which it interacts.

Problem Determination Table

Important!: Remember - If ezCallerID is not performing as it normally does, stop and restart it. There 
will be no data loss and it automatically connects itself to the OSS server.

Table 5-3: ezCallerID Problem Determination (1 of 2)

What if... Then Do...

[cnamgw: Retrying connection to host ‘paris’ 
port 1570]
[cnamgw: Retrying connection to host ‘paris’ 
port 1570]
10092-- Communication failure
  - No Orbix daemon at node : paris
  [Completion status : COMPLETED_NO]

CORBA communication Error when the remote CORBA host 
(OSS) is not available. This should prompt the System 
Administrator to check out the CORBA daemon (Orbix) and 
PSR Ancillary API server on the OSS system. Most likely 
someone rebooted the OSS, shutdown processes, or the 
UNIX machine is down.

Message - startup: Make sure 
namemgr is running before you 
start the agent.

Increase the time interval (seconds) between when the 
namemgr process starts and subsequent processes.

Message - Can’t create SAP.  Make sure that 
namemgr is running

Increase the time interval (seconds) between when the 
namemgr process starts and subsequent processes.

The transfer protocol link between the 
ezCallerID and the Service Center is 
interrupted while sending an order (document).

The ezCallerID keeps every document that goes through it in 
a persistent database. If the acknowledgement (997) is not 
received from the Service Center within a the time you 
specify, the order (document) is sent again.
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The transfer protocol link between ezCallerID 
and the Service Center is interrupted while 
receiving a notification message.

See Transfer Protocol corrective actions.

The link between ezCallerID and the OSS 
breaks while transfering a document

As determined by the OSS Server. Any complete document 
that reaches ezCallerID is stored in a persistent database.
The Gateway has a variable that determines the number of 
times the gateway retries to send the order. Any orders not 
sent, will ultimately reside in the Drop subdirectory of the 
Log directory.

The UNIX system the ezCallerID runs on 
crashes

Restart the CORBA process daemon, restart Oracle database 
instances, roll-back the Oracle databases to the last good 
transactions, and start the ezCallerID application.

Check the Logs and make sure CNAM documents were 
written to the CNAM Oracle Database.
To automatically start the CNAM Gateway during system 
reboot, include the cnam startup script as a UNIX startup 
daemon.

The ezCallerID application goes down. The Gateway restart es every time it goes down. Since all the 
documents and user ID login information is in a persistence 
database, there will not be any loss of information

The Service Center system breaks down. If the notification message is not received from the Service 
Center within the time you set, the document is sent again.

The OSS server breaks down.
The ezCallerID will be waiting to receive transactions. When 
the OSS server comes back up, the ezCallerID will reconnect 
to it.

This Message displays:
D_usr_opendb failed

Make sure the database files specified in the configuration 
files exist and have the correct permissions.

This Message appears:
Can’t create SAP.  Make sure 
that namemgr is running

Issue the ps command to verify namemgr is running.  If the 
process is running, the time lag between the namemgr 
process and the other processes in the startup config file 
is too small.  Stop the ezCallerID application, edit the 
$DP_DIR/cnam/config/cnam.startup file to increase the time 
lag and restart the Gateway.

A terrorist strike happens. DSET believes you are on your own when this happens. Best 
of Luck!

Table 5-3: ezCallerID Problem Determination (2 of 2)

What if... Then Do...
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Actions to Resolve Problems

This section provides a brief description of the responses you can use to overcome problems 
with the ezCallerID application’s environment.

Should problems arise with the Gateway, the first thing to check are the processes.   Veri
the processes listed in "Application Process Health" on page 5-3 are all performing prop
If not, stop and restart the ezCallerID application.  This will specify whether the problem 
in the Gateway or in one of the applications integrated with.

Restarting the ezCallerID Application

To restart the ezCallerID, use the UNIX machine where the application resides. Login as
ezCallerID System Administrator with the recommended.

Note: To ensure that the Gateway has successfully shutdown, issue the ps command and verify that 
all ezCallerID processes are not running after stopping the Gateway. Similarly, issue theps 
command to verify that all ezCallerID processes are running after starting the ezCallerID

1. Enter command: $DP_DIR/cnam/bin/cnam stop

Response would be similar to:

Info : ./cnam invoked on pts/2 by cnam
Date : Mon Nov 1 18:59:07 CST 1999
Checking for environment variables
Killing Process Id 4820
CNAM successfully shutdown

2. When all processes have stopped, restart the ezCallerID Gateway by typing comm

$DP_DIR/cnam/bin/cnam start
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Manually Ending ezCallerID Processes

If executing the cnam stop script does not end all the ezCallerID gateway processes, you 
can manually stop the processes using the ps and kill –2  commands.  Manually stop the 
process IDs for the following processes: thttpd, startup, namemgr, cnamgw, 
secAgent, and cnamIgp.

3. If the ezCallerID application was not successfully started, you may receive this message 
and need to manually terminate the application processes with the kill  command.

/ezConnect/home/cnam/cnam2.0.6/cnam/d-dir/files/
.CNAM.start.pid.cnam does not exist
You may not have started CNAM

4. If not, determine the process identification number for individual process names with the 
command:

ps -ef | grep <ezCallerID_process_name>
The Process Identification (PID) is listed.

5. Using the PID number from Step 4, terminate the process with the command:
kill -2 <ezCallerID_process_name PID>

Note: This last line means you need to find the process  that belongs to the owner cnam and 
manually kill this process.

6. Make sure ALL ezCallerID processes have stopped:

ps -ef|grep <ezCallerID_processes>

Replace <ezCallerID_processes> with each process: startup, lsrgw, 
cnamIgp, secAgent, namemgr, and thttpd
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Checking namemgr

Several processes in the ezCallerID use the namemgr to register information.  If it is not 
running, the following message may appear:

Can’t create SAP.  Make sure that namemgr is running

Issue the ps command to see if namemgr process is running.  If the namemgr process is 
running and this problem occurs, the time lag between the namemgr process and the other 
ezCallerID processes in the startup config file is not sufficient. 

1. Stop the ezCallerID application (see 

2. Using a text editor to modify the $DP_DIR/cnam/config/cnam.startup  file. 

3. increase the time lag and 

4. restart the Gateway.

Verifying Database Access

The secAgent and cnamIgp processes need access to database files to input or access 
information.  If they can not access the database, the following message may appear:

D_usr_opendb failed

Make sure the database files specified in the configuration files exist and have the correct file 
permissions.

Starting the ezCallerID Gateway

1. Start from directory: $DP_DIR/cnam/bin

2. Type the command: cnam stop

3. Make sure all CNAM processes have stopped: ps -ef|grep <LSR_processes>
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Replace <CNAM_processes> with each of these processes: startup, lsrgw, 
lsrIgp, secAgent, namemgr, and thttpd.

4. When all processes have stopped, restart the Gateway from the same directory:
cnam start

CORBA (Orbix) Software

Determine if CORBA Daemon Running

To verify that Orbix is running properly (for CORBA/OSS configuration users):

1. From the console that the software was installed, type the command:

ps -aef | grep orbixd

Manually Kill the CORBA Daemon Process

These are the UNIX commands that force the CORBA (Orbix) process to terminate:

PID=‘ps -ef |grep orbixd |grep -v grep|awk ’{ print $2 
}’‘

if [ -n "$PID" ]; then

  kill -9 $PID 2>&1 >/dev/null

fi

Manually Start the CORBA Daemon Process

2. If the Orbix daemon is not running, switch to directory: /etc/rc2.d

3. Type the command: ./S99iona start

This restarts the Orbix daemon.

4. Restart the CNAM Gateway (see Starting the ezCallerID Gateway on page 5-17).

If the Orbix daemon (CORBA) is running, the OSS is able to contact the CNAM 
Gateway.
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If the Orbix daemon is running and the OSS is unable to contact the LSR Gateway, go to 
$DP_DIR/lsr/config/ and locate file <ILEC>.lsrgw.cfg

5. Using VI or another text editor, edit the variable: RMT_CORBA_HOST_NAME

It needs to match the OSS server’s name in the variable: 
RMT_CORBA_SERVER_NAME

If these variables are consistent, the problem may be in the OSS.

Checking the Oracle Databases

If you see this message: D_usr_opendb failed,check to make sure the oracle 
processes are running by typing:

ps -aef|grep ora

If the CNAM orders (CNAM) and Security databases (CNSECDB) and the LISTENER process
are not running, follow these procedures:

Starting the CNAM Orders Database

1. Login as oracle User Id.

2. Set ORACLE_SID environment variable to IGP_Database by typing:

export ORACLE_SID=CNAM

3. Use the Oracle server manager by commands:

svrmgrl

connect internal

startup

exit (out of the Oracle server manager)
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Starting the Security Agent Database

1. Login as oracle User ID (unless you did it in step 1 for the CNAM Orders database.)

2. Set ORACLE_SID database instance environment variable to Security_Database by 
typing:

export ORACLE_SID=CNSECDB

3. Use the Oracle server manager by commands:

svrmgrl

connect internal

startup

exit (out of the Oracle server manager)

Starting the Oracle Listener

1. Login as oracle User ID (unless you did it in step 1 for the Security Agent database.)

2. Start the listener by typing the commands:

lsnrctl stop
lsnrctl start
exit

Increase the Time Lag for the namemgr Process

Several processes in the ezCallerID Gateway use the namemgr to register information. If it is 
not running, the following message may appear:

startup: Make sure namemgr is running before you start the 
agent.

Verify that the namemgr process is running when this error happens. If the process is running 
and this problem occurs, the time lag between the namemgr and the other processes in the 
startup configuration file is not enough for your system. Increase the time lag, then stop and 
restart the LSR Gateway. 
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Backup and Archival

For the ezCallerID application, the System Administrator will need to backup the ezCallerID 
logs and the actual CNAM orders (documents) stored in the Oracle database. The ezCallerID 
logs can be backed-up with standard UNIX utilities. The Oracle files can be backed-up as 
necessary using the standard Oracle utitlities or the database orders can be archived, removed 
from the files, and any needed disk space reclaimed.

• Backing-up Oracle ezCallerID orders ..............................................................  on page

• Archiving ezCallerID logs................................................................................  on page

When you reach 80% capacity of UNIX disk space or Oracle tablespace size, you need 
begin to archive CNAM documents, along with notification messages and errors. Once y
have archived all documents and files belonging to a specific period (for example, say tw
months), delete the UNIX files and remove the CNAM records from your Oracle databas

ezCallerID Logs Directory

The ezCallerID creates log files on a daily basis. These files tend to get large quickly. W
recommend you set the log files to backup to tape daily (or as frequently as needed bas
your schedule) for retrieval when needed. The names of log files end with the date they 
created.The logs are simple ASCII files and can be backed up using tar or other UNIX ut

They are located in $DP_DIR/cnam/www/cnam/log directory. Three subdirectories are
used for each DSET product to store the daily logs.

The ezCallerID logs reside in directories (see Figure 5-8):

• $DP_DIR/lsr/www/cnam/log/< trading partner>/CnamIgp

• $DP_DIR/lsr/www/cnam/log/< trading partner>/Canmgw

• $DP_DIR/lsr/www/cnam/log/< trading partner>/Security

The <trading partner>  is usually expressed as a three or four letter ILEC designation 
such as PAC (Pacific Bell), SWB (Southwestern Bell), USW (US West), etc.

(See Table 5-2 for a description of the different logs.)
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Figure 5-8: Log Directory Structure

Backup CNAM Orders (documents)

To prevent from running out of storage space, it is recommended that the ezCallerID document 
output files be removed periodically.  These files should be backed up to tape prior to deleting 
them. 

1. To remove CNAM documents stored in the Oracle database, the Oracle DBA needs to:
> Stop the ezCallerID application with the appropriate script
> Bring Oracle CNAM database offline and stop the ezCallerID listener processs.
> Use SQL*PLUS commands to archive orders.
> Delete desired CNAM document records.
> Free up space in the actual user_data datafile:

$ORACLE_MOUNT/oracle1/oradata/CNAM/user01.dbf
> Mount the CNAM Oracle database and turn-on the listener process
> Start the ezCallerID application.

Web Server Root Directory

CNAM Log Root Directory

cnamgw cnamIgp Security

Trading
Partner 2

Trading
Partner 3

Trading
Partner 1

. . . . . .
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Backing up Messages and Errors

2. To remove CNAM notification messages and errors, type the commands:

cd $DP_DIR/cnam/DATA/ACNTS/<Service_Center1>
tar uvf /dev/rmt0 /input <--- use tape on /dev/rmt0
rm -rf /input
cd ../<Service_Center2>
tar uvf /dev/rmt0 /input
rm -rf /output
<continue for each service center>

Backing up the Logs

The names of log files end with the date they were created. We recommend that the ezCallerID 
log files are backed-up to tape weekly.  The logs are simple ASCII files and can be backed up 
using standard UNIX utilities.  After backups, you can delete the log files so that the system 
does not run out of space.

3. To remove CNAM log files, type the commands:

cd $DP_DIR/cnam/www/cnam/log/<Service_Center1>
tar uvf /dev/rmt0 /cnamgw <--- use tape on /dev/rmt0
rm -rf /cnamgw <--- remove gateway logs
tar uvf /dev/rmt0 /cnamIgp 
rm -rf /cnamIgp <--- remove interconnectiovity gateway platform logs
tar uvf /dev/rmt0 /Security 
rm -rf /Security <--- remove security logs
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Oracle Database Maintenance

Handling Database Instances

This section describes the handling of the Oracle database instances created by the DBA. The 
database instances are created by the specifications, after matching the customer requirements 
on the number of CNAM orders per week or by month. Once the database instances are 
created, you can let the ezCallerID System Administrator register the database schema by 
running the DSET ezCallerID Installation script. Once the schema is registered, it is ready for 
population with the CNAM orders (documents).

If the Oracle databases are not prepared before you run the ezCallerID Installation script, you 
must manually run the SQL scripts found in the DSET schema directory:

$DP_DIR/cnam/schema

You have to use these scripts to perform the schema registration and other Oracle operations. 
(See DSET ezCallerID product subdirectories described in Table 2-7.)

Manually Registering Oracle Schema

Schema registration will overwrite any existing schema if any and will makes the Oracle DB 
instance ready to receive orders. This needs to be done for the first time when the DB instances 
are created. The SQL scripts that describe the table definitions and the organization of the 
fields:

• regSch.sql

• regGenSch.sql
Called by regSch.sql to perform name change conversions for schema.)

• regIgpSch.sql

• regSecSch.sql.

The cnam Oracle database instance needs the regGenSch.sql  and regIgpSch.sql 
scripts.

The cnsecdb Oracle database instance needs the regGenSch.sql  and regSecSch.sql 
scripts to define the tables.
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Important!: The table creation operations can be modified to suit the needs of your specific site. Your 
Oracle DBA can suggest script changes based upon the storage location, access 
performance, indexing, disk mirroring capabilities, etc. Check with your Oracle DBA 
regarding these scripts, have the DBA examine the scripts, and get approval before 
registering the ezCallerID schema. Skipping this step may affect the performance of the 
ezCallerID Gateway.

Manually Register the ezCallerID Order Database Schema

To manually register the Oracle ezCallerID orders Database schema, you must go through 
these steps:

1. Start the CNAM Orders Database

Login as oracle User Id.
Set ORACLE_SID variable by typing: export ORACLE_SID=CNAM

2. Start the CNAM Orders Database with the Oracle server manager with commands:

svrmgrl
connect internal
startup
exit (out of the Oracle server manager)

3. Login as oracle User ID (unless you did it in Step 1) and start the listener by 
typing the commands:

lsnrctl stop
lsnrctl start
exit

CAUTION

These scripts contain the table definitions and table creation operations. The table definitions 
should never be changed, as this will effect the operation of the ezCallerID gateway system.
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4. Run the two scripts to define the ezCallerID orders CNAM Oracle database tables:

cd $DP_DIR/cnam/schema
export $IGP_DB_NAME=CNAM
regSch.sql dbadm/dbadm@CNAM $DP_DIR/cnam/schema  
regIgpSch.sql >>/dev/null <continuation of command>

5. Use these commands in a script to test for successful manual registration:

if [ $? != 0 ]; then
  echo
  echo "Warning : register $IGP_DB_NAME schema failed."
  echo "There may be permission problems"
  echo
else
  echo
  echo "Register the ezCallerID CNAM Oracle database"
  echo "schema is done."
  echo
fi

Manually Register ezCallerID Security Database Schema

To manually register the Oracle ezCallerID Security Agent Database schema, you must go 
through these steps:

1. Start the CNAM Orders Database

Login as oracle User Id.
Set ORACLE_SID variable by typing: export ORACLE_SID=CNSECDB

2. Start the CNAM Security Database with the Oracle server manager with commands:

svrmgrl
connect internal
startup
exit (out of the Oracle server manager)
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3. Login as oracle User ID (unless you did it in Step 1) and start the listener by 
typing the commands:

lsnrctl stop
lsnrctl start
exit

4. Run the scripts to define the ezCallerID security CNSECDB  Oracle database tables:

cd $DP_DIR/cnam/schema
export $SEC_DB_NAME=CNSECDB
regSch.sql dbadm/dbadm@CNSECDB $DP_DIR/cnam/schema 
regSecSch.sql >>/dev/null <continuation of command>

5. Use these commands in a script to test for successful manual registration:

if [ $? != 0 ]; then
  echo
  echo "Warning : register $SEC_DB_NAME schema failed."
  echo "There may be permission problems"
  echo
else
  echo
  echo "Register the ezCallerID CNAM Oracle database"
  echo "schema is done."
  echo
fi

Cleaning Up Oracle DB Schema

Cleaning up the Oracle database schema involves “dropping” the tables and the records
is sometimes necessary, if the schema provided in on the DSET distribution media has t
changed for any of these reasons:

• Tablespaces for the database tables need to be modified.

• Table indexing must to be changed to ensure better performance.

• Storage spaces (initial extent, next extent size, etc.) suggested by your Oracle DBA n
be modified.
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To clean-up the Oracle database schema, you need to:

1. Drop the current schema from the datbase instances

2. Modify the contents of the corresponding schema registration SQL scripts.

3. Re-register the appropriate schema as described in "Manually Registering Oracle 
Schema" on page 5-24.

The Oracle SQL scripts that define which database tables are dropped:

• dropDB.sql

• dropGenDB.sql
Called by dropDB.sql to drop the tables that describe the schema name changes.)

• dropIgpDB.sql

• dropSecDB.sql.

The CNAM Oracle database instance needs the dropDB.sql  and dropIgpDB.sql  
scripts.

The CNSECDB Oracle database instance needs the dropDB.sql  and dropSecDB.sql  
scripts to drop its tables.

Dropping the ezCallerID Orders Database

1. If the Oracle ezCallerID Orders database is not online, repeat the first three steps found in 
"Manually Register the ezCallerID Order Database Schema" on page 5-25.

2. Run the script to drop the tables containing the ezCallerID orders in the CNAM Oracle 
database:

cd $DP_DIR/cnam/schema
export ORACLE_SID= CNAM
dropDB.sql dbadm/dbadm@CNAM $DP_DIR/cnam/schema  
dropIgpSch.sql >>/dev/null <continuation of command>
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Dropping the ezCallerID Security Database

1. If the Oracle Security Agent database is not online, repeat the first three steps found in 
"Manually Register ezCallerID Security Database Schema" on page 5-26.

2. Run the script to delete the Oracle security database tables:

cd $DP_DIR/cnam/schema
export ORACLE_SID=CNSECDB
dropDB.sql dbadm/dbadm@CNSECDB $DP_DIR/cnam/schema  
dropSecDB.sql >>/dev/null <continuation of command>

Deleting Existing Oracle Database Records

The ezCallerID orders (documents) that populated the Oracle CNAM database tables, can be 
deleted using one of the scripts provided by DSET Corporation. You may want to do this if you 
want to start over with a clean database instance, after your company has finished its initial 
testing.

The Oracle SQL scripts that define which tables to delete:

• delDB.sql

• delGenDB.sql
Called by delDB.sql to delete the tables that describe the schema name changes.)

• delIgpDB.sql

• delSecDB.sql.

The CNAM Oracle database instance needs the delDB.sql  and delIgpDB.sql  scripts.

The CNSECDB Oracle database instance needs the delDB.sql  and delSecDB.sql  
scripts to delete its tables.

CAUTION

Prior to re-starting the ezCallerID application, you must re-register the Oracle database 
schema using the procedures in "Manually Register the ezCallerID Order Database Schema" 
on page 5-25 and in "Manually Register ezCallerID Security Database Schema" on page 5-26.
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Deleting CNAM Order Tables

1. If the Oracle ezCallerID Orders database is not online, repeat the first three steps found in 
"Manually Register the ezCallerID Order Database Schema" on page 5-25.

2. Run the script to delete the ezCallerID orders CNAM Oracle database tables:

cd $DP_DIR/cnam/schema
export ORACLE_SID=CNAM
delDB.sql dbadm/dbadm@CNAM $DP_DIR/cnam/schema  
delIgpSch.sql >>/dev/null <continuation of command>

Deleting Security DB  tables

1. If the Oracle Security Agent database is not online, repeat the first three steps found in 
"Manually Register ezCallerID Security Database Schema" on page 5-26.

2. Run the script to delete the Oracle security database tables:

cd $DP_DIR/cnam/schema
export ORACLE_SID=CNSECDB
delDB.sql dbadm/dbadm@CNSECDB $DP_DIR/cnam/schema  
delSecDB.sql >>/dev/null <continuation of command>
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Glossary A
This glossary provides a description of abbreviations, acronyms, and terminology used in the 
DSET ezCallerID product guides. 

Table A-1: Glossary  (1 of 3)

Abbreviation/
Acronym

 Description

CLEC Competitive Local Exchange Carrier
The new group of deregulated telecommunications providers that 
compete on a selective basis to provide long distance, celular, and other 
services.

CNAM Calling Name Delivery
Former name for the ezCallerID application. The name and telephone 
number of the originating party is displayed on a Caller ID device at the 
destination subscriber’s telephone.

CORBA Common Object Request Broker Architecture
CORBA is an industry specification for the design of Object Request 
Brokers (ORBs). ORBs allow different kinds of computer systems to 
exchange object data with each other. PowerBRoker is an example of an 
Object Request Broker that conforms to the CORBA specification.

DSI DownStream Interface
The portion of the gateway that collects service orders into files, 
translates data into the desired format, and sends the data to a service 
center. The interface also receives confirmation and error messages, 
reformats them, and passes the files back to the user interface.

GUI Graphical User Interface
The generic name for any computer interface that substitutes graphic 
elements (windows, menus, drop-down selection lists, and so on) for 
character commands.

IDL Interface Definition Language
OMG's Interface Definition Language, an implementation-neutral 
language used to specify interface definitions in CORBA.

IGP Interconnectivity Gateway Platform
The portion of the DSET software that controls storing service order 
documents and the resulting notification messages.
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ILEC Incumbent Local Exchange Carrier
A traditional, old incumbent local exchange carrier that was part of the 
Bell System or an Independent Local Exchange Carrier such as GTE or 
Alltel.

NPA Number Plan Area
A fancy way of saying area code of the telephone number.

OCN Operating Company Number
A valid operating company number thats required for portable 
exchanges.

OSS Operations Support System
Methods and procedures that directly support the daily operation of the 
telecommunications infrastructure. The average Local Exchange Carrier 
has hundreds of systems supporting order negotiation, order processing, 
line assignment, line testing, and billing.

PDF Portable Document Format
A format developed by Adobe to allow printed documents to retain 
formatting while viewed online with multiple operating systems. DSET 
transforms its written documents into PDF for distribution to customers.

PON Purchase Order Number
A unique number automatically assigned to the service order by the 
ezCallerID application.

SC Service Center
A clearinghouse that collects and processes roaming and billing 
information from a number of carriers. It then transfer the compiled data 
(including confirmation codes and error messages) to the proper carriers.

SCP Service Control Point
A remote database within the System Signaling 7 network which supplies 
the translation and routing data needed to deliver advanced network 
services.

SMS Service Management System
An SS7 operations support system (OSS) used to help the provisioning 
and loading of data into the ezCallerID/ezCallingCard service control 
point (SCP) database.

Table A-1: Glossary  (2 of 3)

Abbreviation/
Acronym

 Description
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TBS Telecom Business Solution
The Operation Support System (OSS) provided by MetaSolv Software 
that acts as a user-interface to create CNAM orders through the DSET 
ezCallerID gateway.

TNS Transparent Network Substrate
A simple way to manage many combinations of communications 
protocols that can access a single Oracle database instance.

UFS UNIX File System
The tree-structured file system supported by the UNIX operating system.

URL Universal Resource Locator
An internet address that locates a file on any computer connected to the 
Internet in the world. The URL is ultimately translated to a TCP/IP 
address and a directory location on that computer.

Table A-1: Glossary  (3 of 3)

Abbreviation/
Acronym

 Description
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Technical Reference B
This chapter describes the technial processes of the ezCallerID and the configuration 
parameters necessary to run the application. 

Process Flow

This illustration shows a high-level process flow of the ezCallerID and how the components 
interact with each other.

Figure B-1: High Level Process Flow of ezCallerID components

GUI thttpd

startup
cnamgw

cnamIgp

secAgent

namemgr

ILEC 
Service 
Center

KEY:

ezCallerID process

ezCallerID component
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Configuration Files

The ezCallerID uses a set of configuration files to setup the directory paths and customize the 
variables to your environment.

The configuration files for the startup, namemgr, secAgent, cnamIgp, and cnamgw 
processes are:

• $DP_DIR/cnam /d-dir/etc/D_nameTailor

• $DP_DIR/cnam /d-dir/etc/EDB

• $DP_DIR/cnam /config/<prefix>.cnamIgp.cfg

•  $DP_DIR/cnam /config/<prefix>.cnamgw.cfg

• $DP_DIR/cnam /config/security.cfg

• $DP_DIR/cnam /config/cnam.startup

Note: These filenames are case sensitive.

What was Installed

Now that your installation was successful, this is a list of all the processes now running:

• secAgent

• thttpd

• cnamigp

• namemgr

• cnamgw

• startup - The script used to start the application

Configuration Files

The configuration files in $DP_DIR/cnam/config directory:
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• security.cfg

• <prefix>.cnamgw.cfg

• <prefix>.cnamIgp.cfg

• cnam.startup

Executable Files

The executable files in $DP_DIR/cnam/bin directory:

• igpApp

• cnam

• cnamIgp

• cnamgw

• profile

• secAgent

• startup

• thttpd

Note: The namemgr executable is in $DP_DIR/cnam/d-dir/bin directory.

Log Directories

The log directories in $DP_DIR/cnam/www/cnam/log:

• cnamigp

• cnamgw

• Security
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Startup Script

This script, CNAM.startup, invokes and monitors the four component processes of 
ezCallerID.  If any one of the five processes stops, the startup script stops all processes and 
restarts them.

The five processes invoked by the startup script are:

• ../d-dir/bin/namemgr

• ./secAgent

• ./cnamIgp

• ./cnamgw

• ./thttpd

These processes should be running at all times when the exCallerID Gateway is running

To start the exCallerID Gateway, use the UNIX system where it resides.

1. Start in directory: $DP_DIR/cnam/bin

2. Enter script: cnam start

The following is a sample of the output if cnam.startup is running:

cnamadm 13461     1  0   Dec 04 pts/20  0:00 startup /export/home/cnamadm/cnamGW/
config/cnam.startup

DO NOT EDIT this script. Unlike the other scripts, cnam.startup is a script that should 
NOT be edited.  None of the variables relate directly to machines outside the exCallerID
Gateway, therefore changing variables without checking the Gateway’s internal processe
would be likely to incapacitate the system.

You may need to check the script to see whether all four processes are running, and whe
the processes are referring correctly to the same external machines.

This process takes about 30 seconds to run.
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Stop Script

To stop ezCallerID, use the UNIX system where it resides.

1. Start in directory: $DP_DIR/cnam/bin

2. Type the script name and parameter: cnam stop

This invokes the igpApp script with the ’stop’ parameter.

This process takes about 10 seconds to run.

To set script variables, enter: /CNAM_INSTALL_DIRECTORY/cnam/profile

3. At $HOME/, locate file .kshrc 

4. Use VI or another text-editing tool to add the following line:

. /CNAM_INSTALL_DIRECTORY/cnam/profile
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Checking Gateway Status

As System Administrator, you need to check the status of the ezCallerID. You can do this from 
any UNIX machine.

1. On any UNIX terminal, at the command prompt, enter command:

ps -aef | grep startup

The system will reply will be similar to:

cnamadm 14951  1 0 19:51:04 pts/8  0:00 startup/export/home/
cnamadm/cnamGW/cnam/config/cnam.startup

(cnamadm is an example of a username, and 14951 is a sample process ID)

Instead of running this for startup, you can replace startup with cnamgw, secAgent, igpAgent, 
or namemgr.  These 5 processes should always be running, and results should always resemble 
the sample above.
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Verifying ezCallerID Status

As the ezCallerID administrator, you can check the status of ezCallerID.

At the command prompt, type:

ps –aef | grep startup <Enter>

The result will look like the following:

cnamadm 14951  1 0 19:51:04 pts/8  0:00 startup

Note: cnamadm is an example of a username and 14951 is a sample process id. 

To check for the other processes, replace startup with namemgr, secAgent, cnamIgp, cnamgw 
and thttpd. 
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Checking the Web Server

The web server (thttpd daemon) is an http server that should be running on the UNIX machine 
where the Gateway resides.  This process is started as part of the startup process.  To access the 
ezCallerID windows through an HTML browser, first check to make sure that the web server is 
running:

Enter command: ps –aef | grep thttpd

If it is running, the response will be similar to:

cnamadm 16103 23455  0 16:09:14 pts/20   0:00 thttpd

If the web server (or thttpd daemon) is not running, start it in the background from the 
$DP_DIR/cnam /bin directory.  Enter command:

./thttpd -p port number -d $DP_DIR/www/cnam &

Note: The port number is a 4-digit value that refers to the port number where ‘thttpd’ should run.
$DP_DIR/www/cnam is the ‘root’ directory for the ‘thttpd’ server.

Although the web server is included as part of the ezCallerID, you may configure it to use
other web servers.  Verify that the log directories are configured in the web server root 
directory.   You should also comment-out the thttpd line in the cnam.startup script file and
your own web server to this file.
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Removing ezCallerID

Remove the ezCallerID from your system by deleting all the files in the cnam directory.

BE MORE SPECIFIC AT THIS POINT

#

#  Variables that DCAMS for generic agent.

SCHEMA_DCAM=
/ezConnect/home/cnam/cnam2.0.5/cnam/bin/libIgpSch.so

MANAGER_DCAM=
/ezConnect/home/cnam/cnam2.0.5/cnam/bin/libIgpMgr.so

BEH_DCAM=
/ezConnect/home/cnam/cnam2.0.5/cnam/bin/libcnambehD.so

DB_DCAM=

# Added for LIDB

SCC_COMPANY_CODE=DSET

SCC_COMPANY_NAME=DSET

OUTPUT_DIR_NAME=
/ezConnect/home/cnam/cnam2.0.5/cnam/DATA/ACNTS/111111/output

COUNTY_ID=1234

STATE_ID=TX

LIDB_AGENT_NAME=cnamAgent
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SVC_CENTER_NAME=111111

SCC_REALEASE_NUMBER=100

SCC_FORMAT_VERSION=1
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Catalog of Windows and Fields C
Service Centers

Creating New Service Center

To Access: Service Centers > Create a New Service Center 

Figure C-1: Create Service Center window

Viewing Service Centers

To Access: Service Centers > View all Service Centers

Table C-1: Field Constraints for Create Service window

Field Name Length - Type Description (possible values)

Service Center 6 digits
The 6 digit code associated with the 
Service Center.

Description 1-100 alphanumeric characters A description of the Service Center.
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Figure C-2: Service Centers window

Figure C-3: Service Center Info window
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DownStream Interface

Creating DownStream Interface Information

To Access: DownStream Interface > Create DSI

Figure C-4: Create DSI window

Table B-2: Field Value Constraints for Create DSI Information Window

Field Name Length - Type Description (possible values)

Service Center 6 digits
The 6-digit code associated with the Service 
Center. Choose from the drop-down selection 
list.

DownStream Frequency
This information is entered in the 
WeekMask window or the Periodic 
Interval window.

Indicates how often the system should check 
for downstream messages.
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Setting Week Mask Download Frequency

Figure B-5: Week Mask (add new schedules) window
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Figure B-6: Interval of Day window

Setting Periodic Download Frequency

Figure B-7: Interval window

Table B-3: Field Value Constraints for Interval Of Day Window

Field Name Length - Type Description (possible values)

Min 1-2 digits
The time interval in minutes to 
check for downstream information.

Table B-4: Field Value Constraints for Interval Window

Field Name Length - Type Description (possible values)

Seconds 1-5 digits
The time interval in seconds to 
check for downstream information.
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Modifying DSI Information

To Access: DownStream Interface > Modify DSI

Figure B-8: Modify DSI Info window

Figure B-9: Modify DSI Info (details) window

Viewing DownStream Interface Information

To Access: DownStream Interface > View DSI Info
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Figure B-10: Get DSI Info window

Figure B-11: DSI Info window
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Viewing WeekMask Download Frequency

Figure B-12: Week Mask window
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Viewing Periodic Download Frequency

Figure B-13: Interval window
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ezCallerID Documents

Creating ezCallerID Documents

To Access: ezCallerID > Create ezCallerID Document

Figure B-14: ezCallerID Create window

Viewing ezCallerID Documents

Table B-5: Field Value Constraints for ezCallerID Create Window (1 of 2)

Field Name Length - Type Description (possible values)

OTC Number
(also known as Service Center)

6 digits
The 6-digit code associated with the account name of a 
Service Center defined. The Service Center numbers are 
defined by the System Administrator.

NPA 3 digits
The first 3-digits of a station number in the format of NPA-
NXX-LineNumber.

NXX 3 digits
The next 3-digits of a station number in the format of 
NPA-NXX-LineNumber.

Line Value
(Line Number)

4 digits
The last 4-digits of a station number in the format of NPA-
NXX-LineNumber.
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OCN
4 alphanumeric 
characters

A valid Operating Company Number acting as the Billing 
Service (required for portable exchanges).

RAO
3 alphanumeric 
characters

A valid Revenue Accounting Office.

Calling Name
15 alphanumeric 
characters

Subscriber name or spaces

Transaction Type 1 alphabet

Type of customer transaction:
• I = Insert new line number record
• C = Change record
• D = Delete record

Presentation Indicator 1 alphabet
Caller ID display option:

• A = Calling name to be displayed
• R = Block name from displaying

Effective Date
6 alphanumeric 
characters

Format MM-DD-YY.
Only use if you want a future processing date.

Table B-5: Field Value Constraints for ezCallerID Create Window (2 of 2)

Field Name Length - Type Description (possible values)
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To Access: ezCallerID > View ezCallerID Document

Figure B-15: Get ezCallerID Documents window

Figure B-16: ezCallerID Documents window

Figure B-17: ezCallerID Documents Info window
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EXISTING CATALOG FROM SYSTEM ADMIN MANUAL

Privilege Levels Screens

Creating New Privilege Levels

Access by: Admin > Privilege > Create
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Figure B-18: Privilege Level Create window

Modifying Privilege Level

Access by: Admin > Privilege > Modify

Table B-6: Field Value Constraints for Privilege Level Create Window

Field Name Length - Type Description (possible values)

Privilege Level Up to 8 digits
The privilege level indicator that determines the 
functions a user can perform.

Privilege Type 100 alphanumeric characters
A description of the functions a user can perform 
when given this privilege level.

Privilege Operations Choose from the list
A set of operations that determines which 
functions the user can perform.
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Figure B-19: Privilege Level Modify window

Viewing Privilege Levels

To Access: Admin > Privilege > View

Figure B-20: Privilege Level View Request window

Table B-7: Field Value Constraints for Privilege Level Modify Window

Field Name Length - Type Description (possible values)

Privilege Level Up to 8 digits
The privilege level indicator that determines the 
functions a user can perform.

Privilege Type 100 alphanumeric characters
A description of the functions a user can perform 
when given this privilege level.

Privilege Operations Choose from the list
A set of operations that determines which functions 
the user can perform.
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Figure B-21: Privilege Level View window

Figure B-22: Privilege Level View Response window
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User Groups Screens

Creating amd Modifying New Users

To Access: Admin > User Menu > Create new User Then next,  
Admin > User Menu > Modify

Figure B-23: User Create window

Viewing All Users

To Access: Admin > User Menu > View Then next,  click OK

Table B-8: Field Value Constraints for User Create Window

Field Name Length - Type Description (possible values)

User ID 1-8 alphanumeric characters The ID of the user that is being added to the system.

Privilege Level Up to 8 digits
The privilege level indicator associated with this user’s 
ID. This level determines the functions the user can 
perform.
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Figure B-24: User View Response window

Figure B-25: User View Response window
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Index 3

-A-
Acrobat Reader

displays online manual xviii
activity logs

example contents 5-11–5-12
allocate disk space

Oracle databases 2-12
application installation

See installation
applications

components 1-7
documentation 2-28
DSET gateway

Oracle performance 5-25
DSET log directories 5-8
environment

creating 2-22
established 2-28
installation 2-22
required information 2-23
variables 2-48

gateway startup 2-53
home directory 2-2
login 3-1
naming conventions 2-18
uninstalling 2-58
UNIX crash 5-14
UNIX User ID 2-22

-B-
backups

DSET installation 2-57
books

references for installation 2-3

browser access
See web browser

-C-
Calling Name Delivery (CNAM)

defined A-1
CD-ROM

DSET installation 2-27
check

disk space 5-2
status 5-3

checking
disk space 5-1
process health 5-3

checklist
planning for installation 2-2

clean-up
Oracle databases

reasons 5-27
CLEC See Competitive Local Exchange Carrier
CNAM See ezCallerID
commands

df and du 5-2
non-functional 3-8

Competitive Local Exchange Carrier (CLEC)
defined A-1
new provider 1-1

configuration
choices available 2-23
integrated CORBA/OSS 2-23, 2-35
standalone GUI 2-54

configuration files
DSET application 2-26
ILEC trading partners 2-19
Oracle databases 2-11

conventions
typographical xviii
November 15, 1999 1091-B DRAFT Index-1



Index ezCallerID System Administration Manual
CORBA
check process 2-52
definition A-1
gateway 2-2
home directory 2-37
register DSET processes 2-44
remote names

host 2-39
server 2-39

software
home directory 2-2
installation 2-6
troubleshooting 5-18

customer service
change configuration files 2-41
contacting xx
dial-in procedures 2-58
installation 2-19

-D-
defaults

HTTP daemon port number 2-33
Security Agent port number 2-33
server port number 2-33

dial-in procedures
coordinate with customer service 2-58

disk space
checking 5-1
CNAM orders (documents) 2-8
CNAM orders in Oracle 5-2
free kilobytes 5-2
issues 5-2
Oracle databases

allocated by scripts 2-12
requirements

DSETinstallation 2-2
third-party software 2-2

User IDs and privileges 2-7
diskspace

allocated kilobytes 5-2

documentation
DSET application 2-28
DSET database creation 2-8
installing Oracle software patches 2-5

DownStream Frequency. See DownStream Interface
DownStream Interface (DSI)

defined A-1
DownStream Frequency 3-13, 4-7, 4-16

Periodic 4-10
WeekMask 4-7

modifying 4-11
operating at a selected interval 3-14, 4-17
operating at selected times 3-12, 4-15

drop
Oracle database tables 5-28

DSET Installation Team
activities 2-19

DSI
description 4-5

DSI See DownStream Interface
due dates

possible states 1-5

-E-
editing

scripts
Oracle databases 2-13

environment
DSET application 2-28

environment variables
access by system administrator 2-47
DSET application 2-48
Oracle databases

CNAM orders 5-2
Oracle directory pathnames 2-9
Oracle/CORBA

validate 2-49
setting 2-47
validate for DSET 2-48
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examples
activity log contents 5-11–5-12
activity log shows order 2-57
application port numbers 2-32
CORBA process active 2-52, 5-4
DSET application startup 2-53
DSET processes running 2-53
environment variables

CORBA 2-49
DSET application 2-49
Oracle software 2-50

log file names 5-9
shared object libraries 2-51

-F-
field descriptions

displayed in status area xx
file directories

application
processes 2-26

application configuration 2-26
application logs 5-8
CNAM orders in Oracle 5-2
CORBA software 2-37
DSET applications 2-24
DSET databases 2-10
DSET installation 2-2, 2-24
DSET product subdirectories 2-25
gateway activity 5-8
logs 2-26
Oracle databases

administration 2-10
SQL scripts 2-26

Oracle environment variables 2-9
Oracle software 2-9, 2-38
organization for logs 2-27, 5-6, 5-22
security actions 5-8
shared library paths 2-50
trading partner (ILEC) 2-36–2-37

files
DSET application home page 2-43
listener 2-18
Oracle databases

init/config 2-11
init/config file links 2-12
links to startup 2-12
listener 2-17
scripts to create 2-12
TNS names 2-15

profile
holds environment variables 2-47

TNS names 2-15
trading partners

naming conventions 2-18
finding

Oracle software patches 2-5
frequencies 3-13, 4-16

-G-
gateway

check status 5-3
define process name 2-35

Graphical User Interface (GUI)
defined A-1
starting DSET application 2-54

GUI See Graphical User Interface

-H-
home directories

CORBA Orbix software 2-2
CORBA software (Orbix) 2-37
DSET application 2-2
Oracle software 2-38

home pages
DSET application 2-43, 2-54

hosts (UNIX)
define CORBA name 2-40
DSET application 2-42
remote CORBA name 2-39
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HTTP Daemon
installation port number 2-33

-I-
IDL See Interface Definition Language
IGP See Interconnectivity Gateway Platform
ILEC See Incumbent Local Exchange Carrier
Incumbent Local Exchange Carrier (ILEC)

current provider 1-1
defined A-2
naming 2-36

initial steps
create service center 2-55
Downstream Interface created 2-55

initialization files
Oracle databases 2-11

installation
activities done by DSET 2-19
application environment 2-28
assigned port numbers 2-32
backups 2-57
copy files

distribution media 2-27
CORBA 2-2
disk space

checking 2-29
requirements 2-2
third-party software 2-2

DSET script
final steps 2-44
instructions 2-29
responses 2-33

environment details 2-30
hardware 2-2
initial hardware and software 2-2
initial sysadmin procedures 2-58
Java browser support 2-2
key configuration decision 2-35
operating system 2-2
Oracle databases

preliminary steps 2-20

ready 2-34
order creation configuration 2-35
OSS software 2-2
overview 2-1
planning checklist 2-2
possible configurations xix, 2-23
post-install tasks 2-46
RAM memory 2-2
references 2-3
relational database 2-2
requires Oracle 8 software 2-34
Security Agent

process name 2-36
specify trading partner 2-36
third-party software 2-4
UNIX commands required 2-22

integrated configuration
choose during installation 2-35
definition 2-23
libraries required 2-51
requirements 2-22

Interconnectivity Gateway Platform (IGP)
defined A-1

Interface Definition Language (IDL)
Caller ID customer records 1-7
defined A-1

Internet Browser See Web Browser
intervals

jeopardy 1-5
provisioning 1-5

-J-
Java Applets

supported byweb browser 2-2
jeopardy interval

can miss due date 1-5

-K-
keyboard keys

typographical conventions xviii
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Korn shell
source variables automatically 2-47

-L-
libraries

required for configuration 2-51
links

overwriting existing 2-12
login

connecting user to ezCallerID 3-1
logs

activity
order received 2-57

CNAM order activity 5-10
directories 5-8
directory structure 2-27, 5-6, 5-22
documents through gateway 5-10
examples of names 5-9
file directories 2-26
security actions performed 5-10
security activity 5-8
trace actions for orders 5-10
trace IGP software actions 5-8, 5-10
tracking a service order 5-7
types for DSET applications 5-10

-M-
manual

changes xix
menus

overview of ezCallerID commands 3-8
typographical conventions xviii

messages
User ID Login 3-5

-N-
namemgr

key process 5-20

names
CORBA

remote host 2-39
remote server 2-39

Oracle database instances 2-41
Security Agent process 2-35–2-36

naming conventions
application 2-18
ILEC trading partner 2-18

navigation 3-8
network communications

Oracle databases 2-15
nonfunctional commands 3-8
NPA See Numbering Plan Area
Numbering plan Area (NPA)

defined A-2

-O-
operating system

required for DSET application 2-2
Operations Support Systems (OSS)

defined A-2
MetaSolv TBS software 2-2

Oracle databases
administration files 2-10
clean-up

reasons 5-27
creating

options required 2-6
overview 2-8
scripts 2-13

DBA involvement 5-25
DSET application

User ID 2-14
DSET file directories 2-10
estimating disk space

CNAM documents 2-8
security agent 2-7

init/config files 2-11
instances

description 2-17
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names 2-2, 2-41
links to startup files 2-12
listener file

editing 2-17
starting 2-18

maintenance 5-24
mounting (bring online) 2-14
names used 2-7
network communications 2-15
Orders

delete tables 5-30
drop tables 5-28
steps to register schema 5-25

performance tuning 5-27
ready for installation 2-34
reference books 2-3
registering schema

manually 5-24
registering schemas

automatically 2-44
manually 5-25–5-26
messages 2-45

scripts
running 2-13

security
steps to delete tables 5-30
steps to drop tables 5-29
steps to register schema 5-26

software requirements 2-2, 2-4
verify online 2-52, 5-4

Oracle software
file directories 2-9
home directory 2-38
patches

finding 2-5
Sun Sparc specific 2-6
uninstalling 2-6

order status
current state 1-4

orders (documents)
delete tables 5-30
disk space estimation 2-8
drop tables 5-28
examining DSET logs 2-56
gateway waiting period 2-40
Oracle database

instance name 2-41
register database schema 5-25
testing gateway 2-56

organization
manual xvii

OSS See Operations Support Systems
OSS server

link breaks with gateway 5-14
overviews

basic environment preparation 2-22
creating Oracle databases 2-8
DSET database creation 2-8
instalaltion script responses 2-33
installation 2-1
post-instalaltion tasks 2-46
pre-installation tasks 2-2
preventative monitoring 5-1

-P-
passwords

changing 3-24
defaults

system administrator 2-55, 3-24
modifying 3-5
requirements 3-24

patches
Oracle software 2-5–2-6

Sun Sparc specific 2-6
PDF See Portable Document Format
Periodic Frequency 3-13, 4-16

schedule 3-13, 4-16
Periodic. See DownStream Interface
PON See Purchase Order Number
Index-6 1091-B DRAFT November 15, 1999



ezCallerID System Administration Manual Index
port numbers 2-33
example for DSET products 2-32
HTTP daemon process 2-43
Security Agent 2-39
TCP/IP gateway 2-39
uniqueness for applications 2-32

Portable Document Format (PDF)
defined A-2
viewing xviii

preventiative monitoring
overview 5-1

Privilege Levels
delete/change levels

warning 3-20
privilege levels 3-17

creating 3-19
deleting 3-23
modifying 3-20
operation codes 3-17
samples 3-18
viewing 3-21

problems
determination matrix 5-13
evaluating situations 5-13
symptoms 5-13

procedures
delete tables

orders database 5-30
security database 5-30

done after installation 2-58
drop tables

orders database 5-28
security database 5-29

register schema
orders database 5-25
security database 5-26

processes
checking health 5-3
CORBA

verify 2-52
DSET application

testing 2-53
file directories 2-26
gateway

defining name 2-35
HTTP daemon

port number 2-43
names

restrictions for gateway 2-35
Security Agent 2-36

Oracle databases
verify 2-52

registering with CORBA 2-44
shared object libraries 2-51
UNIX ID 5-3

profile file
Oracle environment variables 2-10

profile files
DSET application 2-47
sourcing 2-47

provisioning interval
time for service availability 1-5

Purchase Order Number (PON)
defined A-2

-R-
RAM memory

required for installation 2-2
reference books

help during installation 2-3
installation 2-3

requirements
password 3-24

-S-
SC See Service Centers
SCP See Service Control Point
scripts

DSET application
establish environment 2-28

DSET installation
final steps 2-44
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finish message 2-45
responses 2-33

installation
file directory 2-48

Oracle databases
allocate disk space 2-12–2-13
creation/maintenance 2-26
deleting tables 5-29
dropping tables 5-28
DSET creation 2-12
edit for DSET 2-13
running 2-13
schema registration 5-24

Oracle SQL
avoid modifying 5-25

prepares environment 2-30
security

changing your password 3-6
disk space estimation 2-7

Security Agent
delete database tables 5-30
drop database tables 5-29
Oracle database

instance name 2-42
overview 1-9
port number 2-33, 2-39
process name 2-36
register database schema 5-26

servers
DSET application gateway 2-42
remote CORBA name 2-39–2-40
TCP/IP port number 2-33

Service Centers (SC)
creating 4-1
defined A-2
displaying a list 3-9, 4-13
problems 5-14
viewing 4-3

Service Control Point (SCP)
defined A-2

Service Management System (SMS)
defined A-2

Service Orders
tracking 5-7

SMS See Service Management System
software

DSET application
components 1-7

software features
new in this release xix

sourcing
DSET application profile 2-47
Oracle environment variables 2-10

starting
DSET application 2-53–2-54

startup
Oracle databases

bring online 2-14
init/config files 2-12

Oracle listener file 2-18
states

ezCallerID order 1-4
status

gateway 5-3
system administrators

default passwords 2-55
default User IDs 2-55

-T-
tables

deleting 5-29
dropping 5-28
Oracle databases

installation 2-44
TAR tape

DSET installation 2-27
TBS See Telecom Business Solutions
TCP/IP

gateway port numbers 2-39
host computer address 2-42
server port number 2-33

Telecom Business Solutions (TBS)
CORBA software
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troubleshooting 5-18
defined A-3

tests
after DSET install script 2-46
CORBA daemon active 2-52, 5-3
DSET processes running 2-53
Oracle databases

online 2-52, 5-4
verify order created 2-56

TNS names
communiucation protocol 2-16
connection descriptors 2-17
files 2-15
listener file 2-17

TNS See Transparent Network Substrate
trading partners

designate during installation 2-36
file naming conventions 2-18
log directories 2-37

Transparent Network Substrate (TNS)
defined A-3

troubleshooting
CORBA software 5-18
list of problems 5-13
namemgr 5-20

-U-
UFS See UNIX File System
Uniform Resource Locator (URL)

defined A-3
start DSET application 2-43

uninstalling
DSET application 2-58
Oracle software patches 2-6

UNIX commands
installation script requirements 2-22

UNIX File System (UFS)
defined A-3

UpStream Frequency 3-13, 4-16
URL See Uniform Resource Locator

User Groups 3-24
creating 3-24
modifying 3-25

User IDs
defaults for system administrator 2-55
DSET application 2-22–2-23, 2-30
Oracle

DSET application 2-14
user’s manual

organization xvii
viewing online effectively xviii

-V-
validate

correct installation 2-46
DSET environment variables 2-48
orders through gateway 2-56

viewing
data transfer schedules 3-11, 4-14
online manual xviii

-W-
waiting period

changing config file 2-41
extract OSS orders 2-40

web browser
accessing DSET application 2-54
login to ezCallerID 3-1
requires Java applet support 2-2

Web server
thttpd daemon B-8

WeekMask
schedule 3-13, 4-16

WeekMask. See DownStream Interface
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windows
Activity Log Detail 5-11–5-12
Create DSi C-3
Create Service Center C-1
DSI Info 3-12, 4-15, C-7
ezCallerID Create C-10
ezCallerID Documents C-12
ezCallerID Documents Info C-12
ezCallerID Gateway Console 3-4
Get DSI Info 3-11, 4-14, C-7
Get ezCallerID Documents C-12
Index of Activity logs directory 5-9
Interval C-5
Interval (periodic frequency) 3-14, 4-17
Interval (viewing) C-9
Interval of Day 3-14, 4-17, C-5
log directories 5-8
Login Response 3-4
Logout 3-7
Modify DSI Info C-6
Modify DSI Info (details) C-6
Service Center Info 3-10, 4-13, C-2
Service Centers 3-9, 4-13, C-2
top-level server root 5-7
Week Mask 3-13, 4-16
Week Mask (create schedules) C-4
Week Mask (viewing) C-8
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